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Design Master Photometrics

You are reading the user manual for Design Master Photometrics 1.2.

You can download a PDF version of the user manual for printing and offline documentation purposes.

Technical Support

M -F, 9am - 5pm Eastern

support@designmas ter.biz
1-866-516-9497 x2

Copyright 2012-2023, Design Master Software, Inc.

Overview

Design Master Photometrics is an add-in for AutoCAD and Brics CAD that calculates outdoor illuminance levels.
It allows civil engineers and landscape architects to perform their own outdoor site lighting calculations.

Mluminance Levels: Calculate point-by-point illuminance levels on your site plan and have them displayed
directly on your drawing.

AutoCAD or Brics CAD Based: Work in the familiar AutoCAD or BricsCAD interface, rather than learning an
unfamiliar new program.

Uniformity Ratios: Calculate the uniformity ratios required by your local jurisdiction.
Isolines: Display isolines on your drawing to highlight critical illuminance levels.
Light Fixture Manufacturer Independent: Import IES files fromany lighting manufacturer.

Design Changes: Make changes to the design and get immediate feedback on your lighting calculations without
waiting for your lighting rep or another consultant.

Light Fixture Schedule: Display a schedule on the drawing of all of the fixtures used in the project.

Buildings, Overhangs, Slopes, and Trees: Model obstructions and different ground elevations to accurately
calculate lighting levels.

Training Videos

® Photometrics Overview



https://files.designmaster.biz/DMPhotometrics_UserManual.pdf
mailto:support@designmaster.biz
http://www.designmaster.biz/support/blog/2018/03/training-recording-photometrics-overview/

Command Reference

This section describes all of the commands available in Design Master Photometrics. It is a direct listing of all of
the commands and what they do. More complete discussions about how to apply the commands are found in the
Concepts and Procedures section.

The commands in this section are in the same order as the Design Master Photometrics pulldown menu:

Calculate

Cuery
o |nsert Light Fidure
@  Edit Multiple Light Fixtures
5 Array Light Fidures (2 Point]
" Array Light Fodtures (Distance / Angle)
i, Aim Light Fixture

Light Fixture Motes >

Light Fixture Project Schedule
Insert Light Fiture Project Schedule
Light Fixture Master Schedule

Insert Calculation Area
Insert Sloped Calculation Area
Insert Calculation Line

Insert Sloped Calculation Line

NN &

Insert Mask
Calculation Area Groups ¥
Calculation Schedules >

Insert Solid: Shape
Insert Solid: Rectangle
Insert Solid: Line

Insert Vertex in Area or Solid

Remowve Vertex from Area or Solid

Turn Construction Layers On

el =7 7T NI &

Turn Construction Layers Off

Litilities ¥
Help -]
Customization >

Start Mew Photormetrics Project



Calculate

The calculate command is used to calculate the illuminance levels on the drawing based upon the light fixtures
and solids that have been inserted.

To run photometric calculations, go to

Ribbon: pM Photometrics->Calculate-> Calculate

Pulldown Menu: DM Photometrics->Calculate

Calculate Photometrics Dialog Box

Calculate Photometrics >
Contours Display
lluminance Layer or Color (@) Show lluminance Levels and Contours
Contour 1: |5 | |BYL-'1'-.YEH | Set Color. . . () Show lluminance Levels Only
Contour2:  [2 | [BYLAYER | | SetColor... O Show Cortours Orly
Decimal Places on Drawing: |1 |
Contour 3: |1 | |BYLAYEH | Set Color. . .
Decimal Places in Schedule: |2 |
Contour 4: |[:- | |BYL.'!-.YEH | Set Color. . .
Distance Unit: | |noh »
Contour 5: ||} | |BYL.'1WEH | Set Color. . . _ _
lluminance Unit: | Foot-candie »
Contour 6: |D | |BYL.’-WEH | Set Colar. . . Reflections: | pone -
Contour 7: |D | |BYL-’-WEH | Set Color. . . Boundary Areas
Gonfour &: |D | |BYL-'—‘~.YEH | Set Color. . Edit Title, Column Labels, and Column Order. . .
Boundary Li
Cortour 9: |[:- | |B~r|_.f-\~rEH | Set Calor. . . cunaan Hnes
Edit Title, Calumn Labels, and Column Order. . .
Contour 10: |[:- | |B~r|_.f-\~rEH | Set Calor. . .

[] Zoom to Schedule After Insertion

Cancel

Contour Level 1 -10: Enter the illuminance level at which to draw contours. You can have up to 10 contours.
Contours set to 0 will not be drawn.

Layer or Color: Enter the layer or color of the contour. If the layer specified does not exist on the drawing, it will
be created. Press the Set Color button to open the standard CAD Select Color dialog box.

Show Illuminance Levels and Contours: Select this option to show illuminance levels and contours on the
drawing. The illuminance levels and contours will be displayed in the calculation area after the calculation is
finished.

Show Illuminance Levels Only: Select this option to show illuminance levels on the drawing. The illuminance



levels will be displayed in the calculation area after the calculation is finished.

Show Contours Only: Select this option to show contours on the drawing. The contours will be displayed in the
calculation area after the calculation is finished.

Decimal Places on Drawing: The number of decimal places to include in the illuminance levels on the drawing.

Decimal Places in Schedule: The number of decimal places to include in the illuminance levels on the schedule. If
the Decimal Places on Drawing is less than the Decimal Places in Schedule, the smaller Decimal Places on
Drawing will be used for the Maximum Illuminance and the Minimum [lluminance values in the schedule.

Distance Unit: The base unit for your drawing. See the Base Units and Photometrics Calculations article in the
knowledge base for more information about determining the correct Distance Unit setting for your drawing.

¢ Inch: One unit on the drawing corresponds to one inch. The standard base unit for US architectural
drawings.
Foot: One unit on the drawing corresponds to one foot. The standard base unit for US civil drawings.
Millimeter: One unit on the drawing corresponds to one millimeter.
Centimeter: One unit on the drawing corresponds to one centimeter.
Meter: One unit on the drawing corresponds to one meter.

Nluminance Unit: Whether the illuminance levels are displayed in foot-candles or lux.

Reflections: Whether the calculation includes reflections from walls.
® No Reflection: No reflections are included in the calculation. This option is faster, though the calculated
values will be slightly lower than reality for inside calculations and near walls outside.
¢ Single Reflection: Light is reflected once during the calculations. This option takes longer, but results in
higher values near solids. The light is reflected off of one surface to the ground. Light that hits a second
surface is not reflected. For example, light that goes fromthe light to a wall to the ground is included. Light
that goes fromthe light to the floor to a wall, then back to the floor, is not included.

Edit Title, Column Labels, and Column Order: Press these buttons to modify the layout of the photometric
schedule for general calculation areas and general calculation lines on the drawing. See the Edit Calculation
Schedule Layout section and Edit Calculation Line Schedule Layout section for more information.

Zoom to Schedule After Insertion: Whether the display will be moved to the schedule associated with the
calculation area.

Calculating Photometrics

After all of the information has been entered, press the OKbutton.
If there is only one calculation area in the drawing, the illuminance levels in the area will be calculated.
If there is more than one calculation area in the drawing, you will be prompted to specify which area to calculate.
Select calculation area to calculate / <Calculate all boundaries>:
Select calculation area: Select a point inside an area to calculate the illuminance levels in just that area.

Calculate all boundaries: Press ENTER to calculate the illuminance levels in all areas on the drawing.


https://www.designmasterphotometrics.com/?p=2165

The illuminance levels and contours in the area that is calculated will be updated. The values in the
corresponding photometric calculation schedule will also be updated.

Related Options

Schedule title justification: Sets the justification for the schedule title.

Schedule column label justification: Sets the justification for column headings.

Schedule title continued label: Sets the label added to the schedule title for continued sections.

There are several options that set the default values for this dialog box. See the Photometric Calculations
Options section for more information.

Edit Calculation Area Schedule Layout

The Calculation Schedule Label Display and Order dialog boxis used to configure the appearance of the
photometric calculation area schedule on the drawing.

To change the appearance for the current project, use the Calculate command and press the Boundary Areas:
Edit Title, Column Labels, and Column Order button. Changes made this way will affect the current project.

To change the appearance in the master database, use the Edit Calculation Area Schedule Standards List
command. Changes made this way will affect newly created projects.

General Photometric Schedule Label Display and Order
Dialog Box



GM General Photometric Schedule Label Display and Order
Move Up Move Down
Justification | Display

Schedule Title GEMERAL PHOTOMETRIC SCHEDULE

Average llluminance AVERAGE FOOT-CAMDLES Left
Maximum llluminance MAXIPMURM FOOT-CANDLES Left
Minimum [lluminance MIMIMUR FOOT-CANDLES Left
Minimum to Maximum llluminance Ratio MIMIMUM TO MAXIMUM FC RATIO Left
Maximum to Minimum llluminance Ratio MAXIPMUR TO MINIMUM FC RATIO Left
Average to Minimum llluminance Ratio AVERAGE TO MINIMUM FC RATIO Left
Label Column Width Label Column Width Left
Value Column Width Value Colurmn Width Left
Average to Maximum llluminance Ratio AVERAGE TO MAXIMUM FC RATIO Left D
Maxirmum to Average lluminance Ratio MAKIMUM TO AVERAGE FC RATIO Left D
Minimurm to Average llluminance Ratio MINIMUM TO AVERAGE FC RATIO Left |
Average Vertical llluminance AVERAGE VERTICAL ILLUMINANCE Left |
Maximum Vertical llluminance MAXKIMUM VERTICAL ILLUMINANCE Left D
Minimum Vertical llluminance MINIMUM VERTICAL ILLUMINANCE Left O
Minimum to Maximum Vertical llluminance Ratio | MINIMURM TO MAXIMUM VERTICAL ILLUMINANCE RATIO Left D
Average to Maximum Vertical llluminance Ratie AVERAGE TO MAXIMUM VERTICAL ILLUMINAMCE RATIO Left D
Maximum to Minimum Vertical llluminance Ratic | MAXIMUM TO MIMIMUM VERTICAL ILLUMINANCE RATIO Left D
Average to Minimum Vertical llluminance Ratio AVERAGE TO MINIMUM VERTICAL ILLUMINANCE RATIO Left |
Maximum to Average Vertical llluminance Ratio MAXKIMURM TO AVERAGE VERTICAL ILLUMINAMNCE RATIO Left D
Minimurmn to Average Vertical llluminance Ratio MINIMUR TO AVERAGE VERTICAL ILLUMINANCE RATIO Left D

Cancel

Grid Columns

Key: The identifier for the column, describing what value it will display. The value in this column is fixed and
cannot be changed.

Label: The name that will be displayed for the row.
Width: The width in inches on the printed drawing.

Justification: The justification of the text values in the column. The justification of the title for the schedule and
ofthe column headers are set using the Schedule title justification options and the Schedule column label
Jjustification option in the Options command.

o Left: The text is left-justified.

® Center: The text is center-justified.

® Right: The text is right-justified.

Display: Whether the row is shown on the schedule. If this is not checked, the value will not be displayed.

Grid Rows

Each row in the list corresponds to a row in the schedule. The rows in the schedule will be ordered as they are
ordered in this dialog box.

Move Up: Move the selected row up in the list.

Move Down: Move the selected row down in the list.



Schedule Title: The title of the schedule. This row is always listed first and cannot be moved up or down. The
Label of this key is the title of the schedule. The Width and Display values of this key are ignored. The width of
the title is based upon the width of the columns in the schedule. The title is always displayed with the schedule.

Average Illluminance: The average illuminance value in the photometric calculation area.
Average to Maximum Illuminance Ratio: The Average llluminance divided by the Maximum Illuminance.

Average to Maximum Vertical lluminance Ratio: The Average Vertical llluminance divided by the Maximum
Vertical Illuminance.

Average to Minimum Illuminance Ratio: The Average llluminance divided by the Minimum llluminance.

Average to Minimum Vertical lluminance Ratio: The Average Vertical llluminance divided by the Minimum
Vertical llluminance.

Average Vertical llluminance: The average vertical illuminance value in the photometric calculation area.
Label Column Width: The width of the label column in the schedule.

Maximum Illuminance: The maximum illuminance value in the photometric calculation area.

Maximum to Average Illuminance Ratio: The Maximum llluminance divided by the Average llluminance.

Maximum to Average Vertical llluminance Ratio: The Maximum Vertical llluminance divided by the Average
Vertical Illuminance.

Maximum to Minimum lluminance Ratio: The Maximum llluminance divided by the Minimum llluminance.

Maximum to Minimum Vertical lluminance Ratio: The Maximum Vertical llluminance divided by the Minimum
Vertical Illuminance.

Maximum Vertical llluminance: The maximum vertical illuminance value in the photometric calculation area.
Minimum Illuminance: The minimum illuminance value in the photometric calculation area.
Minimum to Average llluminance Ratio: The Minimum Illuminance divided by the Average llluminance.

Minimum to Average Vertical llluminance Ratio: The Minimum Vertical llluminance divided by the Average
Vertical Illuminance.

Minimum to Maximum lluminance Ratio: The Minimum llluminance divided by the Maximum llluminance.

Minimum to Maximum Vertical lluminance Ratio: The Minimum Vertical llluminance divided by the Maximum
Vertical llluminance.

Minimum Vertical llluminance: The minimum vertical illuminance value in the photometric calculation area.

Value Column Width: The width of the value column in the schedule.



Edit Calculation Line Schedule Layout

The Calculation Schedule Label Display and Order dialog boxis used to configure the appearance of the
photometric calculation line schedule on the drawing.

To change the appearance for the current project, use the Calculate command and press the Boundary Lines:
Edit Title, Column Labels, and Column Order button. Changes made this way will affect the current project.

To change the appearance in the master database, use the Edit Calculation Line Schedule Standar
command. Changes made this way will affect newly created projects.

General Photometric Line Schedule Label Display and Order
Dialog Box

6M General Photometric Line Schedule Label Display and Order X
| Move Up | | Maove Down |

Key Label Width | Justification | Display

Average llluminance AVERAGE FOOT-CAMDLES Left
Maximum lNluminance MAKIMUM FOOT-CANDLES Left
Minimum llluminance MIMIMUM FOOT-CAMNDLES Left
Minimum toe Maximum lluminance Ratio | MINIMUM TO MAXIMUM FC RATIO Left
Maximum to Minimum llluminance Ratio | MAXIMUM TO MINIMUM FC RATIO Left
Average to Minimum llluminance Ratio AVERAGE TO MIMIMUM FC RATIO Left
Label Column Width Label Column Width 2 Left
Value Column Width Value Column Width 2 Left
Average to Maximum llluminance Ratio AVERAGE TO MAXIMUM FC RATIO Left |
Maximum to Average llluminance Ratio MAXIMUM TO AVERAGE FC RATIO Left O
Minimurmn to Average llluminance Ratio MIMIMUM TO AVERAGE FC RATIO Left D

I OK I | Cancel

Grid Columns

Key: The identifier for the column, describing what value it will display. The value in this column is fixed and
cannot be changed.

Label: The name that will be displayed for the row.
Width: The width in inches on the printed drawing.

Justification: The justification of the text values in the column. The justification of the title for the schedule and
of'the column headers are set using the Schedule title justification options and the Schedule column label
Justification option in the Options command.

o Left: The text is left-justified.

® Center: The text is center-justified.

® Right: The text is right-justified.

Display: Whether the row is shown on the schedule. If this is not checked, the value will not be displayed.

8




Grid Rows

Each row in the list corresponds to a row in the schedule. The rows in the schedule will be ordered as they are
ordered in this dialog box.

Move Up: Move the selected row up in the list.
Move Down: Move the selected row down in the list.

Schedule Title: The title of the schedule. This row is always listed first and cannot be moved up or down. The
Label of this key is the title of the schedule. The Width and Display values of this key are ignored. The width of
the title is based upon the width of the columns in the schedule. The title is always displayed with the schedule.

Average Illuminance: The average illuminance value along the photometric calculation line, including vertical
illuminance levels if they are enabled.

Average to Maximum Illuminance Ratio: The Average llluminance divided by the Maximum Illuminance.
Average to Minimum Illuminance Ratio: The Average Illuminance divided by the Minimum [lluminance.
Label Column Width: The width of the label column in the schedule.

Maximum Illuminance: The maximum illuminance value along the photometric calculation line, including vertical
illuminance levels if they are enabled.

Maximum to Average Illuminance Ratio: The Maximum llluminance divided by the Average llluminance.
Maximum to Minimum Hluminance Ratio: The Maximum Illluminance divided by the Minimum Illuminance.

Minimum Illuminance: The minimum illuminance value along the photometric calculation line, including vertical
illuminance levels if they are enabled.

Minimum to Average Illuminance Ratio: The Minimum Illuminance divided by the Average llluminance.
Minimum to Maximum Hluminance Ratio: The Minimum llluminance divided by the Maximum llluminance.
Value Column Width: The width of the value column in the schedule.

Query

The Query command is used to view and edit the information associated with Design Master Photometrics items
inserted on the drawing. You can query light fixtures, calculation areas, and solid objects.

To view and edit an itemthat is inserted on the drawing, go to

Ribbon: DM Photometrics->Query-> Query
Pulldown Menu: DM Photometrics->Query

You will be prompted to select an item.



Select photometric item to query:

After you select an item, a dialog box will appear with information about that item. The dialog box that appears
depends upon the type of itemselected:

® Query Light Fixture

® Query Calculation Area or Line

® Query Solid

Query Light Fixture

When you select a light fixture using the Query command, the Query Light Fixture dialog boxwill appear.

Query Light Fixture Dialog Box

Cuery Light Fixture >
Callout

B

i, [03

Mumber of Lamps: 1

Lumens / Lamp: 4600

Lamp Depreciation: 1

Am Length: 0

Tatal Lumens (Schedule): 4600

Tatal Lumens (IES): Mo |ES File Selected

Mounting Height ft-in): |D |
Titt: (0 |
Edit. . . Layer System: | pjaw "

IES File: Mone Selected

Cancel

Changes can be made to the light fixture in the same way as when it was inserted. See the Insert Light Fixture
section for more information.

Number of Lamps: Set using the Number of Lamps field in the Light Fixture Product Schedule command.
Lumens / Lamp: Set using the Lumens / Lamp field in the Light Fixture Product Schedule command.

Lamp Depreciation: Set using the Lamp Depreciation field in the Light Fixture Product Schedule command.
Arm Length: Set using the Arm Length field in the Light Fixture Product Schedule command.
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Total Lumens (Schedule): The product of the Lumens / Lamp and Number of Lamps fields set in the Light
Fixture Product Schedule command.

Total Lumens (IES): The total lumens set in the IES file for the fixture.

If a number is displayed, the light output from the IES file will be scaled based upon the ratio of the Total Lumens
(Schedule) value and the Total Lumens (IES) value.

If Absolute is displayed, the IES file uses absolute photometry. The total lumens for the IES file are not provided.
The light output for the fixture will not be scaled based upon the Total Lumens (Schedule) value.

Query Calculation Area or Line

When you select a calculation area or line using the Query command, one of the following dialog boxes will
appear, depending upon the entity you select.

Query Calculation Area / Sloped Calculation Area Dialog Box

CQuery Calculation Area >
[ ]Ovenide Schedule Title

|GEHEF!i.L PHOTOMETRIC SCHEDULE |

Horzontal Calculations

Grd Spacing ft4n): |1D |

Calculation Blevation ft-in): |D |
Set (Grid Origin <

Set Grid Angle <

Wertical Calculations

[ ]Calculate Vertical lluminance Levels & frea Boundary

E |

Ln

[==]

Recalculate lluminance Levels

Cancel
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Cuery Sloped Calculation Area x
[ ] Owvenide Schedule Title

IGENERAL PHOTOMETRIC SCHEDULE |

Horzontal Calculations

Grd Spacing ft4n): |1 0 |

Top Elevation ft4in): |E' |

Bottom Elevation ft4in): |D |
Set Grid Origin <

Set Grid Angle <

Wertical Calculations

[ ] Calculate Vertical lluminance Levels A Area Boundary

E |

Recalculate lluminance Levels

Cancel

Changes can be made to the calculation area boundary in the same way as when it was inserted. See the Insert
Calculation Area and Insert Sloped Calculation Area sections for information about the values in these dialog
boxes.

Set Grid Origin: Press this button to change the point from which illuminance values are calculated for the
selected calculation area. The dialog boxwill close and you will be prompted to specify a point on the drawing.

Specify illuminance grid origin for calculation area:

Set Grid Angle: Press this button to change the angle at which illuminance values are calculated for the selected
calculation area. The dialog box will close and you will be prompted to specify an angle on the drawing.

Specify illuminance grid angle for calculation area / <0>:
Specify two points on the drawing, enter an angle value, or press ENTER to set an angle of 0.

Recalculate lluminance Levels: Whether the queried calculation area will be recalculated when you press the
OK button.

Edit Calculation Line / Sloped Calculation Line Dialog Box
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Edit Calculation Line >
[ ]Ovenide Schedule Title
Schedule Tile: |[SENERAL PHOTOMETRIC SCHEDLILE |

Horizontal Calculations

lluminance Level Spacing ft-n): |'H]' |

Calculation Blevation {ft-in): |{|' |

Wertical Calculations
[ ]Caleulate Vertical lluminance Levels

Wertical Calculation Spacing [F-in: |2 |

Wertical Dizplay Spacing [f-in]: |5 |

B |

E nding “ertizal Calculation Elewation [ft-in];

[]Recalculate lluminance Levels

Cancel

Edit Sloped Calculation Line ot

[ ] Ovenide Schedule Title
Schedule Tile; |[GEMERAL PHOTOMETRIC SCHEDULE |

Horizontal Calculations

lluminance Level Spacing ft-n): |'H]' |

Top Blevation ft4n): |{|' |

Bottom Elevation fft-n): |ﬂ' |

Vertical Calculations
[ ] Calculate Vertical lluminance Levels

Wertical Calculation Spacing [f-in: |2 |

Wertical Dizplay Spacing [ft-in]: |5 |
Ending Yertical Calculation Elewation Above Slope [ft-in]:

[ ] Recalculate lluminance Levels

Cancel

Changes can be made to the calculation line in the same way as when it was inserted. See the Insert Calculation
Line and Insert Sloped Calculation Line sections for information about the values in these dialog boxes.

Recalculate llluminance Levels: Whether the queried calculation line will be recalculated when you press the OK
button.
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Query Solid

When you select a solid using the guery command, the Query Calculation Area dialog box will appear.

Query Solid Dialog Box

Cuery Solid >

Starting Blevation ft4n): D
Ending Blevation ft4n):
Reflectance:

Cancel

See the Common Solids Information section for more information about the values in this dialog box.

Light Fixtures

This section describes how to use light fixtures.

Insert Light Fixture

To insert a light fixture on a drawing, go to

Ribbon: DM Photometrics->Light Fixtures-> ® Insert

Pulldown Menu: DM Photometrics->Insert Light Fixture

Insert Light Fixture Dialog Box
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Insert Light Fixture >

Callout

B

2x? Racessed
dm,_[a

Mumber of Lamps: 1

Lumens # Lamp: 4600

Lamp Depreciation: 1

Am Length:

Total Lumens (Schedule): 4600

Total Lumens (IES): Ma |ES File Selected

Mounting Height ft4n): |E' |

Titt: 0 |
Edit. .. Layer System: | paw w

IES File: Mone Selected

Cancel

Callout: The type of light fixture to be inserted. The list of light fixtures available is defined using the Light
Fixture Project Schedule command.

Mounting Height: The height at which the light fixture is located.

Tilt: The angle in degrees at which the light fixture is tilted. The rotation is in the direction of the insertion angle
of'the light fixture.

Layer System: The layer system controls the layers that are used when the light fixture is inserted on the
drawing. Layer systems can be created using the Layers command. See the Layers section for more information.

To change the layer of a light fixture, change the layer system. Do not change the layer directly in your CAD
program. If you do, it will likely be changed back at some point in the future.

Inserting a Light Fixture

To insert a light fixture on the drawing, press the OKbutton. The settings specified in the dialog box will be used
for the inserted light fixture. You will be prompted to identify where on the drawing the light fixture is to be
inserted.

Specify insertion point:

You will then be prompted for the rotation angle. If the light fixture block is not able to be rotated, this prompt will
be skipped.
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Specify rotation angle:

You will then be prompted to insert another light fixture of the same type. Continue to insert light fixtures, or
press ENTER to finish the command.

Related Options

Insert callout as part of each light fixture: Sets whether the Callout is automatically inserted along with the
fixture.

Display light fixture overlay: Sets whether the light fixture overlay is displayed when inserting light fixtures on
the drawing.

Edit Multiple Light Fixtures

To edit multiple light fixtures, go to

Ribbon: DM Photometrics->Light Fixtures-> # Edit Multiple
Pulldown Menu: DM Photometrics->Edit Multiple Light Fixtures
You will be prompted to select the light fixtures that you want to edit.

Select lights to edit:

The Edit Multiple Light Fixtures dialog box will appear.

Edit Multiple Light Fixtures Dialog Box
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Edit Multiple Light Fixtures >
A
B
Mumber of Lamps:
Lumens / Lamp:
Lamp Depreciation:
Am Length:
Total Lumens (Schedule):
Total Lumens (IES):
Mounting Height ft4n): |E' |
Tit: |0 |
Edit. .. Layer System: | paw w
IES File:
Cancel

Changes can be made to the light fixtures in the same way as when they were inserted. See the Insert Light
Fixture section for more information.

Press the OKbutton to apply the changes to the selected light fixtures.

Array Light Fixtures (2 Point)

The array Light Fixture (2 Point) command is used to array light fixtures on the drawing in a straight
line from the first light fixture to a second point.

Use this command instead of the standard CAD ARRAY command.

To array light fixtures using the 2-point method, go to

Ribbon: DM Photometrics->Light Fixtures-> — Array (2 Point)
Pulldown Menu: DM Photometrics->Array Light Fixtures (2 Point)
You will be prompted to select the light fixtures to array.

Select light fixtures to array:

You will then be prompted to specify a second point for the array.
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End point of array:

Specify a point on the drawing. The distance between the specified point and the first light fixture will be divided
evenly among the light fixtures in the array.

You will be prompted to specify the number of light fixtures in the array, including the selected light fixture.
Number of light fixtures in array (including selected light fixture):
The light fixtures in the array will be generated in the space between the selected light fixture and the end point.

Array Light Fixtures (Distance / Angle)

The Array Light Fixture (Distance/Angle) command is used to array light fixtures on the drawing in a
straight line fromthe first light fixture in a set direction with a set distance between each light fixture.

Use this command instead of the standard CAD ARRAY command.

To array a light fixture using the distance/angle method, go to

Ribbon: DM Photometrics->Light Fixtures-> H Array (Distance/Angle)
Pulldown Menu: DM Photometrics->Array Light Fixtures (Distance/Angle)
You will be prompted to select the light fixtures to array.

Select light fixtures to array:

You will then be prompted to set an offset distance and angle.

Offset distance and angle:

Specify a point on the drawing. The distance between each light fixture in the array is based upon the distance
fromthe first light fixture to the specified point.

You will be prompted to specify the number of light fixtures in the array, including the selected light fixture.

Number of light fixtures in array (including selected light fixture):

The light fixtures in the array will be generated in the direction of the specified point fromthe selected light fixture.
Aim Light Fixture

The aim Light Fixture command is used to aima light fixture at a specific point on the ground.

To aima light fixture, go to

Ribbon: DM Photometrics->Light Fixtures-> #% Aim

Pulldown Menu: DM Photometrics->Aim Light Fixture
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Select the light fixture to be aimed.

Select light fixture:

You will then be prompted to specify the location on the ground where the light fixture will be aimed.
Select point to aim light fixture towards:

The light fixture will be rotated on the drawing to point toward the specified point.

The Tilt will be adjusted based upon the light fixture elevation to point toward the specified point.
See the Insert Light Fixture section for more information about the 7i/t setting.

Light Fixture Notes

This section describes how to use light fixture notes.

Insert Light Fixture Callout

The Insert Light Fixture Callout command is used to insert a single light fixture callout label on the
drawing.

The callout label is linked to the light fixture that it is inserted on. Changing the callout of the light fixture in the
database will change the callout label on the drawing. Erasing the light fixture from the drawing will erase the
callout label.

The callout label is not moved with the light fixture. If the light fixture is moved to a new location, the callout label
must be moved separately.

Light fixture callout labels can also be inserted with each light fixture that is inserted on the drawing. See the
Insert Callout as Part of Each Light Fixture option in the Light Fixtures options section for more information.

To insert a light fixture callout, go to

Ribbon: DM Photometrics->Light Fixtures-> #Z Callout

Pulldown Menu: DM Photometrics->Light Fixture Notes->Insert Light Fixture Callout
You will be prompted to select the light fixture to be labeled.

Select light fixture:

You will then be prompted to specify where the callout will be inserted on the drawing.

Specify insertion point:

The light fixture callout will be inserted in the selected location.
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Related Options

LF callout block: Sets the blocks used for the light fixture callout.

This option can be further customized with the LF callout short label width option.

Insert Note

To insert a light fixture note, go to

Ribbon: DM Photometrics->Light Fixture Notes-> EI Insert
Pulldown Menu: DM Photometrics->Light Fixture Notes->Insert Note
You will be prompted to specify the light fixture to which the note will be added.

Select light fixture to add note to:

Insert Light Fixture Note Dialog Box

Insert Light Fixture Mote et

Mote | Edit. . .

Cancel

Type the note into the Note field and press the OK button.

If the note is longer than one line, press the Edit button and type in the entire note.
You will be prompted to specify where the note will be inserted on the drawing.
Right-click or press space to toggle the leader on or off, press enter to place the note.

When inserting the note, a leader will automatically be inserted if the note is moved far enough away fromthe
light fixture. When the note is too close the the light fixture, the leader will be removed.

Right-click or press SPACE to toggle the leader on or off.

Related Options

You can customize the block used for the leader arrow and its length. See the Leaders Options section for more
information.

20



Edit Note

To edit a light fixture note, go to

Ribbon: DM Photometrics->Light Fixture Notes-> %‘P Edit
Pulldown Menu: DM Photometrics->Light Fixture Notes->Edit Note
You will be prompted to specify the note to be edited.

Select light fixture note to edit:

Edit Light Fixture Note Dialog Box

Edit Light Fixture Mote x

Mote | Edit. . .

Cancel

Enter the revised note into the Note field and press the OKbutton.
Ifthe revised note is longer than one line, press the Edit button and enter in the entire note.
The revised note will be displayed on the drawing in the same location.

Move Note

To move a light fixture note, go to

Ribbon: DM Photometrics->Light Fixture Notes-> % Move

Pulldown Menu: DM Photometrics->Light Fixture Notes->Move Note

You will be prompted to specify the note to be moved.

Select light fixture note to move:

You will then be prompted to specify a new location for the note.

Right-click or press space to toggle the leader on or off, press enter to place the note.

When inserting the note, a leader will automatically be inserted if the note is moved far enough away fromthe
light fixture. When the note is too close the the light fixture, the leader will be removed.

Right-click or press SPACE to toggle the leader on or off.

Related Options
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You can customize the block used for the leader arrow and its length. See the Leaders Options section for more
information.

Rotate Note

To rotate a light fixture note, go to

Ribbon: DM Photometrics->Light Fixture Notes-> Q‘ Rotate

Pulldown Menu: DM Photometrics->Light Fixture Notes->Rotate Note

You will be prompted to specify the note to be rotated.

Select light fixture note to rotate:

You will then be prompted to specify the rotation angle.

Specify rotation angle / <Reset to 0>

Specify a rotation angle, or press ENTER to reset the note to the default rotation angle of 0.

Erase Note

To erase a light fixture note, go to

Ribbon: DM Photometrics->Light Fixture Notes-> % Erase
Pulldown Menu: DM Photometrics->Light Fixture Notes->Erase Note
You will be prompted to specify the note to be erased.

Select light fixture note to erase:

The note and associated leader will be erased.

Insert Elevation Label

The Insert Elevation Label command is used to insert a label on a light fixture that displays the elevation of
the device.

To insert an elevation label on a light fixture, go to
Ribbon: DM Photometrics->Light Fixture Notes-> ELl g1evation
Pulldown Menu: DM Photometrics->Light Fixture Notes->Insert Elevation Label

You will be prompted to specify the light fixture to which the label will be added.
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Select light fixture to add elevation label to:
You will be prompted to specify where the elevation label will be inserted on the drawing.
Right-click or space to toggle the leader on or off.

When inserting the label, a leader will automatically be inserted if the label is moved far enough away fromthe
light fixture. When the label is too close the the light fixture, the leader will be removed.

Right-click or press SPACE to toggle the leader on or off.

Related Options
Block: Sets the block used for the elevation label.
Label: Sets how the elevation is displayed on the label.

You can customize the block used for the leader arrow and its length. See the Leaders Options section for more
information.

Match Note Values and Locations

The Match Note Values and Locations command is used to copy the location and values of notes fromone
light fixture to another. Arrange notes on one light fixture using standard CAD commands and the Move Note and
Rotate Note commands, then use this command to easily copy the values and locations to other light fixtures.

This command will change the values of the notes on the other light fixtures to match the first light fixture you
select.

To copy note values and locations to other light fixtures, go to

Ribbon: DM Photometrics->Light Fixture Notes-> E% Match

Pulldown Menu: DM Photometrics->Light Fixture Notes->Match Note Values and Locations
You will be prompted to specify the light fixture with the note arrangement you want to copy.

Select light fixture to use as source:

You will then be prompted to specify the light fixtures to which the notes will be added in the same relative
location.

Select objects:

The notes will be arranged to match the first light fixture you selected.

Light Fixture Schedule

This section describes how to use light fixture schedules.

23



Light Fixture Project Schedule

The light fixture project schedule contains the light fixtures used in the current project. To create and modify light
fixture types, go to

Ribbon: DM Photometrics->Schedule-> #H Project Schedule

Pulldown Menu: DM Photometrics->Light Fixture Project Schedule

Light Fixture Project Schedule Dialog Box

Light Fixture Project Schedule *
Callout: S Rename. . . Find. ..
<— Previous . . Next —>
Photometric Calculation Information IES File Block
Number of Heads: | gpe - IES File: C:...nk Sandbox'parkingdotdight ies

| 1ES Rotation (Degrees COW): [o |
| ‘ |
| Select IES File. . .
|

MNumber of Lamps: |1

Lumens / Lamp: |4DDDI}

Lamp Depreciation: |1

Load IES File Information

Am Length ftn): [0
[] Defautt Mounting Height fft-n): :I Detach IES Fil Description: Single Pole Mourted
ok Houring Fegn ey = = Block Name: DM_PHOTO-LF51

Select Block. ..

Schedule Information
Include in Schedule

Fixture Description: |OUTDOOR ROADWAY ARCHITECTURALREFL: SPECULAR SEGMENT ALUM ENCL: CLEAR, FLAT GLASS Edi. . .

Lamp Description: |4DD W PS MH ED 28, M5400/H75/ED28P5 |

Watts / Lamp: [0 | Volts: [ 120v 1P 2w v | Ballast: |ELECTRONIC v
Model 1: [SPAULDING LIGHTING, CR1-PAD-H5P | | Ed Note 1: | | | Edt.. [ELECTRONIC |
Model 2: | | | Edt.. | Note2: | | | Edt... | Mounting: [cEll NG v
Model 3: | | Edi. .. |:P|'es=9 Edit to Change - saved from ur=(0179 hﬂ|:| Edit. .
Mew. . . Copy. . . Save Delete
Import from Another Database. . . Import from Light Fixture Master Schedule. . .

Callout: The name of the light fixture type.

Rename: Press this button to rename the displayed light fixture in the schedule. Any labels on the drawing will be
updated.

Find: Press this button to select a light fixture froma list of all of the light fixtures in the schedule. The light fixture
you select will be displayed in the dialog box, allowing you to view and modify it.

Next: Press this button to select and display the next light fixture in the schedule. The next light fixture is
determined by sorting the entries in the schedule alphabetically. If you press this button when viewing the last
light fixture, it will wrap back to the beginning and display the first light fixture.

Previous: Press this button to select and display the previous light fixture in the schedule. The previous light
fixture is determined by sorting the entries in the schedule alphabetically. If you press this button when viewing
the first light fixture, it will wrap to the end and display the last light fixture.
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New: Press this button to create a new light fixture in the schedule.

Copy: Press this button to copy the displayed light fixture in the schedule. The new light fixture will be created
with the same information as the displayed light fixture.

Save: Press this button to save any changes made to the displayed light fixture in the schedule. If you make
changes and do not press this button, you will be prompted to save your changes before selecting a new light
fixture or closing the schedule dialog box.

Delete: Press this button to delete the displayed light fixture type fromthe schedule. If there are any light fixtures
inserted on a drawing in the project that use the light fixture type, you will not be able to delete it. You must first
delete all of the light fixtures fromthe drawings before you can delete the light fixture type.

Photometric Calculation Information

The information in the Photometric Calculation Information section is used during the illuminance level
calculations. All of this information must be provided and be correct for the calculation to be correct.

Number of Heads: The number of heads on the fixture.

® One: Light is distributed once in the direction of the insertion angle of the light fixture.

* Two, 90 degree offset: Light is distributed in the direction of the insertion angle of the light fixture and at
90 degrees counterclockwise.

® Two, 180 degree offset: Light is distributed in the direction of the insertion angle of the light fixture and at
180 degrees.

® Three: Light is distributed in the direction of the insertion angle of the light fixture, at 90 degrees
clockwise, and at 90 degrees counterclockwise.

* Four: Light is distributed in the direction of the insertion angle of the light fixture, at 90 degrees clockwise,
at 180 degrees, and at 90 degrees counterclockwise.

Number of Lamps : The number of lamps in the light fixture.
Lumens/Lamp: The number of initial lumens per lamp.

Lamp Depreciation: The depreciation value of each lamp (Lumens / lamp x lamp depreciation = actual lumens). It
should be less than or equal to 1. Lamp depreciation may include fixture dirt or lens depreciation.

Arm Length: The length of the arm of the fixture. When calculating illuminance levels, the light source is moved
this distance fromthe insertion point of the light fixture block.

Default Mounting Height: The default mounting height when this light fixture type is inserted on the drawing.
The mounting height can be modified for individual light fixtures during and after insertion.

IES File: The IES file that is associated with the light fixture callout. IES files are provided by light fixture
manufacturers and contain photometric information about the fixture. They are necessary in order to calculate the
foot candle levels in your project.

IES Rotation: The counterclockwise rotation of the IES file relative to the fixture in degrees. Use this value to
rotate the IES file if it does not point in the same direction as your light fixture block.

Scale Factor: Multiplies the light output by the number specified. For use with IES files for LED light fixtures.
Select IES File: Press this button to select the IES file for the light fixture. The Select IES File dialog box will
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appear.

B Select IES File >
Loak in: | Tutorial o | @' ? 2 "
l Mame a Date modified Type
_ DMEBackup 8722720128 :06 AM  File folder
Quick access HVAC 8/21/2018 405 PM  File folder
- Photometric 8/8/2018 1:28 PM File folder
|J ADDwatt.ies 8/7/2018 &:25 AM IES File
Desktop
| |
Libraries
This PC
. < >
i File name: |4'I]'I]wa‘rt.ies e |
Metwaork
Files of type: IES Files (*.|ES) ~ Cancel
[ ]Open as read-only

Select the IES file for this light fixture and press the Open button. The IES file will be attached to this light fixture
and you will be asked if the information is to be added to the project schedule.

Design Master Photometrics

Load infarmation from |ES file?
Existing information will be overwritten.

Press the Yes button to add the information to the project schedule. The information contained in the IES file
varies depending upon what the manufacturer provides. You will need to review the information that is loaded to
confirmit is loaded into the correct field and that it contains useful text.

Press the No button to only add the information fromthe IES file used for lighting calculations. The other
information in the light fixture schedule will not be filled in based upon the information in the IES file.

Once an IES file is attached to a light fixture, the file path is displayed in the /ES File field of the dialog box.

Load IES File Information: Press this button to load the IES file information into the project schedule. The
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information contained in the IES file varies depending upon what the manufacturer provides. You will need to
review the information that is loaded to confirmit is loaded into the correct field and that it contains useful text.

You will be asked if the information is to be added to the project schedule.

Design Master Photormetrics

Load information from |ES file?
Existing information will be ovenwritten.

Press the Yes button.
All of the information from the IES file will be loaded into the project schedule.

Detach IES File: Press this button to detach the IES file from the light fixture. The light fixture will have no IES file
associated with it after pressing this button.

Block

The block used to represent the light fixture on the drawing is shown here. The list of blocks can be modified
using the Light Fixture Blocks->Fdit Project List command.

Select Block: This button opens the Select Light Fixture Block dialog box. This dialog boxallows you to
choose the block used to represent the light fixture on the drawing.
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Select Light Fixture Block *

Light Fixture Description
Round Wall Mourted (Small)
Round Wall Mourted (Large)

Square Wall Mounted

Round (Tiny)

Round (Small)

Round (Medium)

Round (Large} Single Fole Mtd
Square (Tiny) Al
Square (Small ) L

2x Wall Mounted Fluorescent Light Fxture Description:

3= Wall Mounted Fluorescent Single Pole Mounted

dx Wall Mounted Fluorescent . .

Track or Wall Wash (Small Light Fixture Block:

Track or Wall Wash {Medium) DM_FHOTO-LF51

Track or Wall Wash (Large)
Ceiling Mounted Exit

Wall Mounted Exit
Emergency

Cancel

Schedule Information

The information in the Schedule Information section is displayed in the light fixture project schedule on the
drawing. It is informational only and not used in the calculations. You can provide it to include a more complete
description of the light fixture in the schedule, but it is not necessary. All of the fields in this section can be left
blank and the calculations will be correct.

Include in Schedule: Whether the light fixture type is displayed in the light fixture schedule that is inserted on the
drawing. Most light fixture types will have this box checked. It is most commonly unchecked for existing light
fixture types.

Fixture Description: A description of the type of light fixture. This description will appear on the light fixture
schedule on the drawing.

Lamp Description: Description of the lamp.
Watts/Lamp: The wattage of each lamp.

Model 1, Model 2, Model 3: A description of the model for the light fixture. In the light fixture schedule, the three

models can be shown in a single column or in three separate columns. See the Edit Light Fixture Schedule List
section for more information.

Volts: The voltage of the light fixture.

Note 1, Note 2, Note 3: These notes can be used as generic note fields that are displayed in the schedule on the
drawing.
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They can also be used to include information for which the software does not include a specific location. In the
column labels, you can change the label on the column for that note to designate it for that information. When the
schedule is printed, you will have a new field that includes the custom information.

Ballast: The type of ballast on the light fixture. Default ballasts are available in the list. To specify a ballast that is
not included in the list, select Custom and enter the value in the field below.

Mounting: How the light fixtures is mounted. Default mounting types are available in the list. To specify a
mounting that is not included in the list, select Custom and enter the value in the field below.

Importing Light Fixtures

See the Importing Light Fixtures section for more information about the Import from Another Database and
Import from Light Fixture Master Schedule buttons.

Related Options
Copy IES files to project folder: Sets whether loaded IES files are copied to the project folder.

Importing Light Fixtures

The Import from Another Database and Import from Light Fixture Master Schedule buttons are used to import
light fixtures to the current project.

Import from Another Database

Press the Import from Another Database button to import light fixtures froma schedule in another project to the
current project. This button can be used to copy an entire schedule or a single light fixture. This button allows
you to reuse light fixture schedules in new projects.

The Select Database to Import From dialog box will appear and prompt you to select the project to import the
light fixtures from.
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B Select Database to Import From >
Lookin: | | | 13 Final Qutput v @ ¥ @
I Mame Date modified Type
_ DMBackup 9/13/2018 812 AM  File folder
Quickaccess ™ 4 clec.dm 9/13/20189:30 AM DM File
Desktop
m
Libraries
This PC
i < >
. File name: w
Ngm | o [oeen ]
Files of type: DM Files {*.dm) o Cancel
[ ]Open as read-only

Select the database from which to import. You must select a Design Master Photometrics database. The database
must be updated to the most current version. If it is not, you will be prompted to open a drawing in the project to
convert the database. After it is updated you will then be able to import fromit.

After you select the database, the Import Record from Another Project dialog box will appear and prompt you to
select the light fixtures to import.
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Import Record from Ancther Project x

Cument Group: General Select Group. . .

Import Ertire Group

2 HEAD POLE
E

HEAD
=
W

(®) Create New Record in Schedule
() Update Cument Record in Schedule

Cancel

Current Group: The group in the other project schedule from which the light fixtures will be imported.
Select Group: Press this button to select a new group from which to import light fixtures.
Import Entire Group: Press this button to import all of the light fixtures fromthe Current Group to the project.

New light fixtures will be created in the project for each light fixture being imported. If a light fixture with the same
name already exists in the current schedule, a new light fixture will be created with (Copy) appended to the light
fixture callout. The existing light fixture will not be modified.

You will be prompted if you want to delete existing light fixtures in the project schedule. If you delete the existing
light fixtures, any light fixtures currently being used will not be deleted.

Record List: The list of light fixtures in the Current Group. Select the light fixtures to import fromthis list. You
can select multiple light fixtures using the SHIFT and CTRL keys.

Create New Recordin Schedule: Select this option to create a new light fixture in the project schedule for each
record being imported. The light fixture will be created with the same name as the light fixture in the other project.
If a light fixture with the same name already exists in the current schedule, a new light fixture will be created with
(Copy) appended to the callout. The existing light fixture will not be modified.

Update Current Recordin Schedule: Select this option to update the current light fixture in the project schedule
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with the information from the imported light fixture. All of the information in the project schedule will be
overwritten.

Import from Light Fixture Master Schedule

Press the Import from Light Fixture Master Schedule button to import light fixtures from the master schedule to
the project schedule after the project has been started. The button allows you to import an entire group or
individual light fixtures.

When you press the button, the Import Master Record dialog box will appear.

Import Master Record >

Cument Group: General Select Group. . .

Import Entire Group

(@) Create New Record in Schedule
() Update Cument Record in Schedule

Cancel

Current Group: The group in the master schedule that the light fixtures will be imported from.
Select Group: Press this button to select a new group from which to import light fixtures.
Import Entire Group: Press this button to import all of the light fixtures fromthe Current Group to the project.

New light fixtures will be created in the project for each light fixture being imported. If a light fixture with the same
name already exists in the current database, a new light fixture will be created with (Copy) appended to the light
fixture callout. The existing light fixture will not be modified.
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You will be prompted if you want to delete existing light fixtures in the project schedule. If you delete the existing
light fixtures, any light fixtures currently being used will not be deleted.

Record List: The list of light fixtures in the master group. Select the light fixture to import from this list. You can
select multiple light fixtures using the SHIFT and CTRL keys.

Create New Recordin Schedule: Select this option to create a new light fixture in the project schedule for each
record being imported. The light fixture will be created with the same name as the light fixture in the master
schedule. If a light fixture with the same name already exists in the current schedule, a new light fixture will be
created with (Copy) appended to the callout. The existing light fixture will not be modified.

Update Current Recordin Schedule: Select this option to update the current light fixture in the project schedule
with the information from the imported light fixture. All of the information in the project schedule will be
overwritten.

Insert Light Fixture Project Schedule

A light fixture schedule that lists all of the light fixtures used in the current project can be inserted on the drawing.

To insert this schedule onto the drawing, go to

Ribbon: DM Photometrics->Schedule-> Insert

Pulldown Menu: DM Photometrics->Light Fixture Schedule->Insert Light Fixture Project
Schedule

Insert Light Fixture Project Schedule Dialog Box

Insert Light Fixture Project Schedule et

Schedule Notes: | Edit. . .

[ ] Maximum Schedule Height: |:| Specify On Drawing
[ ] Zoom to Schedule After Insertion
[ ] 5how Unused Light Fistures

Edit Title, Column Labels, and Caolumn Order. . .

Cancel

Schedule Notes: A note that will appear below the schedule when inserted on the drawing.

Maximum Schedule Height: Whether the schedule has a maximum height. This height is inches on the printed
page.

Ifthis is not checked, the schedule will be in a single schedule.

Ifthis is checked, you can specify the maximum height of the schedule. When the schedule exceeds this height, it
will be continued in a second schedule next to the first. The label of the second schedule will have the Schedule
Title Continued Label option added to it to indicate that it is a continuation of'the first schedule. See the
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Schedules options section for more information.

Specify on Drawing: Press this button to specify the Maximum Schedule Height on the drawing. The dialog box
will be closed and you will be prompted to specify the height.

Specify maximum schedule height:

The distance you enter on the drawing will be used as the maximum height. It is simplest to draw a line straight
down to where the bottom of the schedule should be located.

Zoom to Schedule After Insertion: Whether the display will be moved to the schedule location after it has been
inserted or updated.

Show Unused Light Fixtures: Whether light fixtures in the schedule that have not been inserted on a drawing will
be displayed in the schedule.

Edit Title, Column Labels, and Column Order: Press this button to modify the layout of the light fixture schedule
on the drawing. See the Edit Light Fixture Schedule Layout section for more information.

Inserting or Updating the Schedule on the Drawing

To insert or update the schedule, press the OK button.

Inserting the Schedule the First Time

If the light fixture schedule is not currently inserted on the drawing, you will be prompted for the insertion
location of the schedule.

Specify insertion point for the light fixture schedule:

The location you specify will be used as the top-left corner for the light fixture schedule.

Updating the Schedule Already on the Drawing
If the light fixture schedule is already inserted on the drawing, it will be updated in its current location.

You must update the schedule on the drawing when changes are made to the project schedule. The schedule will
not update automatically.

If additional graphics, such as revision clouds, have been inserted over the schedule graphic, be sure to check
their location after updating the schedule.

Related Options

Schedule title justification: Sets the justification for the schedule title.

Schedule column label justification: Sets the justification for column headings.
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Schedule title continued label: Sets the label added to the schedule title for continued sections.

Edit Light Fixture Schedule Layout

The Light Fixture Schedule Label Display and Order dialog boxis used to configure the appearance of the light
fixture schedule on the drawing.

To change the appearance for the current project, use the Insert Light Fixture Project Schedule command and
press the Edit Title, Column Labels, and Column Order button. Changes made this way will affect the current
project.

To change the appearance in the master database, use the Edit Light Fixture Schedule Master Settings
command. Changes made this way will affect newly created projects.

Light Fixture Schedule Label Display and Order Dialog Box
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GM Light Fixture Schedule Label Display and Order
Mave Down
Justification
Schedule Title LUMINAIRE SCHEDULE
Callout CALLOUT 1 Left
Symbol SYMBOL 1.5 Left
Lamp LAMP 2 Left
Description DESCRIPTION 3.5 Left
Ballast BALLAST 1.5 Left
Maounting MOUNTING 1.5 Left
Model MODEL 2 Left
Model 1 MODEL 1 2 Left O
Model 2 MODEL 2 2 Left O
Model 3 MODEL 3 2 Left O
Volts VOLTS 1.25 Left
Mote 1 NOTE 1 2 Left
Mote 2 NOTE 2 2 Left
Mote 3 NOTE 3 2 Left
Quantity QUANTITY 1 Left
Volts Only VOLTS 1 Left O
Default Elevation DEFAULT ELEVATION 1 Left O
Lumens / Lamp LUMEMS / LAMP 1 Left (|
Total Lumens TOTAL LUMEMS 1 Left D
Lamp Depreciation LAMP DEPRECIATION 1 Left O
|ES File Mame IES FILE 2 Left O
ES File Name and Path | 1ES PATH 3 Left O
Arm Length ARM LENGTH 1 Left O
Short Veoltage VOLTS 1 Left O
Mumber of Heads MUM OF HEADS 1 Left D
QK Cancel

Grid Columns

Key: The identifier for the column describing what value it will display. The value in this column is fixed and
cannot be changed.

Label: The name that will be displayed for the column.

You can define a second header for a column by separating the two headers with a | character. The first header
will be merged across multiple columns with the same first header. See the Column Subheadings in Schedules
article in the knowledge base for more information.

Width: The width ofthe column in inches on the printed drawing.
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Justification: The justification of the text values in the column. The justification of the title for the schedule and
ofthe column headers are set using the Schedule title justification options and the Schedule column label
Justification option in the OQptions command.

o Left: The text is left-justified.

e Center: The text is center-justified.

® Right: The text is right-justified.

Display: Whether the column is shown on the schedule. If this is not checked, the value will not be displayed.

Grid Rows

Each row in the grid corresponds to a column in the light fixture schedule. The top column in the grid is the left-
most column in the schedule.

Move Up: Press this button to move the selected row up in the list. This moves the corresponding column to the
left in the schedule.

Move Down: Press this button to move the selected row down in the list. This moves the corresponding column to
the right in the schedule.

Schedule Title: The title of the schedule. This row is always listed first and cannot be moved up or down. The
Label of this key is the title of the schedule. The Width and Display values of this key are ignored. The width of
the title is based upon the width of the columns in the schedule. The title is always displayed with the schedule.

The other values in the Key column are listed alphabetically below.
Arm Length: The arm length taken fromthe schedule.

Ballast: The ballast taken from the schedule. Each of the Ballast values fromthe schedule will be listed on a
separate line.

Callout: The name of the light fixture as defined in the light fixture schedule.

Default Elevation: The default mounting height taken fromthe schedule.
Description: The description taken fromthe schedule.

IES File Name: The name of the IES file for the light fixture.

IES File Name and Path: The file path for the IES file for the light fixture.

Lamp: The number of lamps, watts per lamp, and description taken fromthe schedule.

Lamp Depreciation: The lamp depreciation taken fromthe schedule. Each of the Lamp Depreciation values from
the schedule will be listed on a separate line.

Lumens / Lamp: The lumens per lamp for the fixture. Each of the Lumens / Lamp values fromthe schedule will be
listed on a separate line.

Model: All three models taken fromthe schedule. Each model will be listed on a separate line.
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Model 1: The model taken fromthe schedule. Each modelis listed in a separate column.
Model 2: The model taken fromthe schedule. Each modelis listed in a separate column.
Model 3: The model taken fromthe schedule. Each model is listed in a separate column.
Mounting: The mounting taken from the schedule.

Note 1: Note taken fromthe schedule.

Note 2: Note taken fromthe schedule.

Note 3: Note taken fromthe schedule.

Number of Heads: The number of heads taken fromthe schedule.

Quantity: The number of light fixtures inserted in the project. If a light fixture type is not inserted, "NOT USED"
will be displayed.

Short Voltage: The voltage value and poles of the light fixture. If Volts is set to Universal, all of the voltages that
the light fixture type is connected to will be listed.

Examples: 120V 1P, 208V 2P

Symbol: The block used to represent the light fixture. The block is rotated and scaled so that it will fit into the
schedule.

Total Lumens: The total lumens for the fixture.

Volts: The full voltage value of the light fixture. The volts, poles, and wires will be displayed. If Volts is set to
Universal, all of the voltages that the light fixture type is connected to will be listed.

Examples: 120V 1P 2W, 208V 2P 2W

Volts Only: The voltage value of the light fixture. Only the volts will be displayed. The poles and wires will not be
displayed. If Volts is set to Universal, all of the voltages that the light fixture type is connected to will be listed.

Examples: 120V, 208V

Light Fixture Master Schedule

The light fixture master schedule contains all of the light fixture callouts that might be used on a project. See the
Master and Standards Databases section for more information about using master databases.

To create and modify callouts in the master schedule, go to

Ribbon: DM Photometrics->Schedule-> @E‘ Light Fixture Master Schedule

Pulldown Menu: DM Photometrics->Light Fixture Schedule->Light Fixture Master Schedule
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Light Fixture Master Schedule Dialog Box

Import from Light Fixture Project Schedule. . .

Light Fixture Master Schedule
Cumrent Group: General Select Group. . .
Callout: 5 Rename. . . Find. ..
<— Previous . Next —>
Photometric Calculation Information IES File Block
Number of Heads: [gne - IES File: C:...nk Sandbox‘parkingdotdight ies
ion (| W) [0
Number of Lamps: [ | IES Rotaton (Degrees CCW) [ |
1
Lumens / Lamp: ‘4DDDD | |
Lamp Depreciation: |1 | FEEEE TR
Am Length ftin): |D | Load IES File Information
[ Defauk Mounting Height fiin): Detach IES Fi Description: Single Pole Mounted
Bl S R LA L 1] = = Block Name: DM_PHOTO-LF51
Select Block. . .

Schedule Information
Include in Schedule
Fixture Description: |OUTDOOR ROADWAY ARCHITECTURALREFL: SPECULAR SEGMENT ALUM ENCL: CLEAR, FLAT GLASS Edit. . .
Lamp Description: |4DD W PS MH ED 28, M5400/H75/ED28P5 |
Watts / Lamp: [0 | Velts: 120v 1P 2w ~| Ballast: | ELECTRONIC v
Model 1: |SPAULDING LIGHTING, CR1-P40-H5P | Edit. .. | pote 1: | | Edit. .. |ELECTROHIC |
Model 2 | | | Edt.. | Nete2: | | | Edt... | Mounting: |cELinG “
Model 3: | | Edit. .. |:P|ess Edit to Change> - saved from ud=(0179 hﬂ|:| Edit. . . CEILING

MNew Copy. . . Save Delete

The Light Fixture Master Schedule dialog box works almost exactly the same as the Light Fixture Project
Schedule dialog box. See the Light Fixture Project Schedule section for more information. The places where it

works differently are described below.

Current Group: The active light fixture group is listed here. All of the light fixture types that are created and

modified will be associated with this group.

Select Group: Press this button to open the Light Fixture Master Schedule Groups dialog box. The group

selected will become the current group.

You can also create and modify the groups available in the master schedule. See the Light Fixture Mas ter
Schedule Groups section for more information.

Move to Another Group: Press this button to move the displayed light fixture to a different master schedule
group. A dialog boxwill appear that will prompt you to select the other group. The Current Group will be
changed to the selected group. This button is disabled if only one group exists.

Copy to Another Group: Press this button to copy the displayed light fixture to a different master schedule group.
A dialog boxwill appear that will prompt you to select the other group. A copy of the displayed light fixture will
be created in the other group. This button is disabled if only one group exists.
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Import from Light Fixture Project Schedule: Press this button to import light fixtures froma project schedule to
the master schedule. This button can be used to copy an entire project schedule or a single light fixture. This
button allows you to create your master schedule froma project schedule.

When you press this button, the Select Database to Import From dialog box will appear and prompt you to
select the project from which the light fixtures will be imported.

A Select Database to Import From x
Lok in: | | | 13 Final Output v @ @
i Mame Date modified Type
_ DMBackup /13/2018 812 AM  File folder
Quickaccess ™ 4 clec.dm 9/13/20189:30AM DM File
Desktop
m
Libraries
This PC
. < >
= File name: | e | | Cpen
Metwork
Files of type: DM Files {*.dm}) w Cancel
[ ]Open as read-only

Select the database from which to import. You must select a Design Master Photometrics database. The
database must be updated to the most current version. If it is not, you will be prompted to open a drawing in
the project to convert the database. After it is updated you will then be able to import fromit.

After you select the database, the Import Record from Another Project dialog boxwill appear and prompt
you to select the light fixtures to import.
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Import Record from Ancther Project x

Cument Group: General Select Group. . .

Import Ertire Group

2 HEAD POLE
E

HEAD
=
W

(®) Create New Record in Schedule
() Update Cument Record in Schedule

Cancel

Current Group: The group in the project schedule from which the light fixtures will be imported.
Select Group: Press this button to select a new group from which to import light fixtures.

Import Entire Group: Press this button to import all of the light fixtures fromthe Current Group to the master
schedule.

New light fixtures will be created in the master schedule for each light fixture being imported. If a light fixture
with the same name already exists in the master schedule, a new light fixture will be created with (Copy)
appended to the light fixture callout. The existing light fixture will not be modified.

You will be prompted if you want to delete existing light fixtures in the master schedule.

Record List: The list of light fixtures in the Current Group. Select the light fixtures to import from this list.
You can select multiple light fixtures using the SHIFT and cTRL keys.

Create New Recordin Schedule: Select this option to create a new light fixture in the master schedule for
each record being imported. The light fixture will be created with the same name as the light fixture in the
project schedule. If a light fixture with the same name already exists in the master schedule, a new light fixture
will be created with (Copy) appended to the light fixture callout. The existing light fixture will not be modified.

Update Current Recordin Schedule: Select this option to update the current light fixture in the master
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schedule with the information from the imported light fixture. All of the information in the master schedule will
be overwritten.

Light Fixture Master Schedule Groups

The Select Group button on the Light Fixture Master Schedule dialog boxopens the Light Fixture Master
Schedule Groups dialog box. This dialog boxis used to create and modify light fixture groups in the master
database.

Groups allow you to organize the light fixtures in your project and master schedules.

When you start a project, all of the light fixtures froma single group can be copied to the project. Copying a
group is helpful when you have a common type of project with similar schedules. You can set up the schedule
once in the master as a group, then reuse it in new projects.

While working on a project, you can import light fixtures froma group into the project. You can create multiple
groups for different types of light fixtures or different manufacturers. The organization of the groups makes it
easier to find the light fixture you want to import.

Light Fixture Master Schedule Groups Dialog Box

Light Fixture Master Schedule G.. X

Rename. . .

Mew. . . Copy. . . Delete

Cancel

Rename: Press this button to rename the selected group.

New: Press this button to create a new group. The group that is created will be empty and have no light fixtures in
it.

Copy: Press this button to copy the selected group. The group that is created will be empty and have no light
fixtures in it.

Delete: Press this button to delete the selected group. You cannot delete a group that still has light fixtures in it.

Press the OKbutton to set the selected group to the Current Group in the Light Fixture Master Schedule dialog
box.
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Calculation Areas

This section describes how to use calculation areas.

Calculation areas determine where illuminance levels will be calculated on the drawing. The illuminance levels are
based upon the light fixtures and solids inserted on the drawing.

Insert Calculation Area

The Insert Calculation Area command is used to insert a flat area on the drawing where illuminance levels
are to be calculated.

To insert a calculation area on the drawing, go to

Ribbon: pM Photometrics->Calculation Areas-> _. Insert

Pulldown Menu: DM Photometrics->Insert Calculation Area

Insert Calculation Area Dialog Box

Insert Calculation Area >
[ ]Ovenide Schedule Title
|‘3EHEF!%L FHOTOMETRIC SCHEDLULE |

Horizontal Calculations

Grid Spacing ftin): |'|I]I |

Calculation Blevation {ft-in): |D |

Wertical Calculations

[ ] Calculate Vertical lluminance Levels & Area Boundary

E |

[==]

Cancel

Override Schedule Title: Whether the schedule title for the current calculation area is to be changed fromthe
default calculation schedule title.

Schedule Title: The title to be used in the calculation schedule for the calculation area. This field is enabled if the
Override Schedule Title boxis checked.

Grid/ Illuminance Level Spacing: The distance between points where illuminance levels will be calculated.

Calculation Elevation: The elevation at which the calculation will be performed.
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Calculate Vertical lluminance Levels At Area Boundary: Whether vertical illuminance levels are to be
calculated at the edges of the calculation area.

Vertical Calculation Spacing: The distance between points where vertical illuminance levels will be calculated.
Vertical Display Spacing: The distance between vertical calculation points as they are displayed on the drawing.

Ending Vertical Calculation Elevation: The maximum height at which vertical illuminance levels will be calculated.

Inserting the Calculation Area on the Drawing

To insert the calculation area on the drawing, press the OKbutton. The settings you specified in the dialog box
will be used for the area.

You will be prompted to draw the calculation area on the drawing.
Specify first point of calculation area or [<Select existing boundary>] :

First point of calculation area: Specify a point on the drawing.Continue entering points on the drawing
until the calculation area is complete. Press ENTER to finish drawing the calculation area.

Select existing boundary: Press ENTER to draw the calculation area by tracing a polyline on the drawing.
Specify the polyline on the drawing to be traced. You will be asked whether to erase the polyline after the
calculation area is inserted.

You will then be prompted to insert the calculation schedule, group the calculation area with another area, or
press ENTER to finish the command.

Specify insertion point for calculation schedule or point inside boundary to group with:

Insert a Calculation Schedule: To insert a calculation schedule, select a point on the drawing that is not
inside of another calculation area. A calculation schedule will be inserted at the point specified.

Group the Area with Another Group: To group the area with another group, select a point on the drawing
that is inside of another calculation area. The two calculation areas will be grouped. If the selected calculation
area already has a calculation schedule on the drawing, it will be used as the calculation schedule for the
group. If it does not have a calculation schedule, no calculation schedule will be used for the group.

Finish the Command: Press ENTER to finish the command without inserting a calculation schedule or
grouping the calculation area with another group. No calculation schedule will be inserted and the
calculation area will be in its own separate group.

Related Options

Schedule title justification: Sets the justification for the schedule title.
Schedule column label justification: Sets the justification for column headings.

Schedule title continued label: Sets the label added to the schedule title for continued sections.
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Default grid spacing: Sets the default value for the Grid Spacing setting.

Insert Sloped Calculation Area

The Insert Sloped Calculation Area command is used to insert a sloped area on the drawing where
illuminance levels are to be calculated.

To insert a sloped calculation area on the drawing, go to

Ribbon: pM Photometrics->Calculation Areas-> IA. Insert Sloped Area

Pulldown Menu: DM Photometrics->Insert Sloped Calculation Area

Insert Sloped Calculation Area Dialog Box

Insert Sloped Calculation Area et
[ ] Ovenide Schedule Title
GENERAL PHOTOMETRIC SCHEDULE |

Horizortal Calculations

Grd Spacing ft4n): |'||3' |

Top Elevation fft-in): |D |

Bottomn Elevation ft-n): |E' |

Wertical Calculations

] Calculate Vertical lluminance Levels & Area Boundary

E |

(=)

Cancel

Override Schedule Title: Whether the schedule title for the current calculation area is to be changed fromthe
default calculation schedule title.

Schedule Title: The title to be used in the calculation schedule for the calculation area. This field is enabled if the
Override Schedule Title boxis checked.

Grid/ Illuminance Level Spacing: The distance between points where illuminance levels will be calculated.
Top Hevation: The elevation at the top of the slope.

Bottom Elevation: The elevation at the bottom of'the slope.
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Calculate Vertical lluminance Levels At Area Boundary: Whether vertical illuminance levels are to be
calculated at the edges of the calculation area.

Vertical Calculation Spacing: The distance between points where vertical illuminance levels will be calculated.
Vertical Display Spacing: The distance between vertical calculation points as they are displayed on the drawing.

Ending Vertical Calculation Elevation Above Slope: The maximum vertical distance at which vertical illuminance
levels will be calculated along each point on the slope. For example, an area with a Top Elevation of 30 and an
Ending Vertical Calculation Elevation Above Slope of 10 will calculate illuminance levels from 30' to 40" at the
top of the slope.

Inserting the Sloped Calculation Area on the Drawing

To insert the calculation area on the drawing, press the OK button. The settings you specified in the dialog box
will be used for the area.

You will be prompted to draw the calculation area on the drawing. The area will be inserted as a rectangle. The top
elevation will be on one side of the rectangle and the bottom elevation will be on the opposite side of the
rectangle. The two connecting sides will slope fromthe top side to the bottomside.

You will draw two lines to define the area. The first line should start at the top elevation of the slope and end at
the bottomelevation of the slope. The top and bottomedges of the boundary will be drawn perpendicular to this
line. The sides of the boundary will be drawn parallel to this line.

The second line you draw should start at one side of the slope and end at the opposite side. The locations of the
sides of'the rectangle will be determined by the start and end points of this line.

You will first be prompted to specify a point on the slope that is at the top elevation.
Specify top of calculation area:

You will then be prompted to specify a point on the slope that is at the bottom elevation.
Specify bottom of calculation area:

You will then be prompted to specify a point on one side of the slope.

Specify point on edge of calculation area:

You will then be prompted to specify a point on the opposite side of the slope.

Specify point on opposite edge of calculation area:

A rectangular boundary will be inserted on the drawing enclosing the specified points. The outline of the
boundary will be thicker at the higher elevation to help you visualize how it slopes.

You will then be prompted to insert the calculation schedule, group the calculation area with another area, or
press ENTER to finish the command.

Specify insertion point for calculation schedule or point inside boundary to group with:
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Insert a Calculation Schedule: To insert a calculation schedule, select a point on the drawing that is not
inside of another calculation area. A calculation schedule will be inserted at the point specified.

Group the Area with Another Group: To group the area with another group, select a point on the drawing
that is inside of another calculation area. The two calculation areas will be grouped. If the selected calculation
area already has a calculation schedule on the drawing, it will be used as the calculation schedule for the
group. Ifit does not have a calculation schedule, no calculation schedule will be used for the group.

Finish the Command: Press ENTER to finish the command without inserting a calculation schedule or
grouping the calculation area with another group. No calculation schedule will be inserted and the
calculation area will be in its own separate group.

Related Options

Schedule title justification: Sets the justification for the schedule title.

Schedule column label justification: Sets the justification for column headings.

Schedule title continued label: Sets the label added to the schedule title for continued sections.

Default grid spacing: Sets the default value for the Grid Spacing setting.

Insert Calculation Line

The Insert Calculation Line command is used to insert a line on the drawing where illuminance levels are
to be calculated.

To insert a calculation line on the drawing, go to

Ribbon: pM Photometrics->Calculation Areas-> I:. Insert Line

Pulldown Menu: DM Photometrics->Insert Calculation Line

Insert Calculation Line Dialog Box
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Insert Calculation Line >
[ ] Owvenide Schedule Title
GEMERAL PHOTOMETRIC SCHEDULE |

Horzontal Calculations

lluminance Level Spacing ft4n): |'|D |

Calculation Blevation {ft-n): |D |

Wertical Calculations

[ ] Calculate Vertical lluminance Levels

E |

[==]

Cancel

Override Schedule Title: Whether the schedule title for the current calculation area is to be changed fromthe
default calculation schedule title.

Schedule Title: The title to be used in the calculation schedule for the calculation area. This field is enabled if the
Override Schedule Title boxis checked.

Grid/ Illuminance Level Spacing: The distance between points where illuminance levels will be calculated.
Calculation Elevation: The elevation at which the calculation will be performed.

Calculate Vertical lluminance Levels At Area Boundary: Whether vertical illuminance levels are to be
calculated along the line.

Vertical Calculation Spacing: The distance between points where vertical illuminance levels will be calculated.
Vertical Display Spacing: The distance between vertical calculation points as they are displayed on the drawing.

Ending Vertical Calculation Flevation: The maximum height at which vertical illuminance levels will be calculated.

Inserting the Calculation Line on the Drawing

You will be prompted to draw the calculation line on the drawing.
Specify first point of calculation line or [<Select existing line>]:

First point of calculation area: Specify a point on the drawing.Continue entering points on the drawing
until the calculation line is complete. Press ENTER to finish drawing the calculation line.

Select existing line: Press ENTER to draw the calculation line by tracing a polyline on the drawing. Specify
the polyline on the drawing to be traced. You will be asked whether to erase the polyline after the calculation
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line is inserted.

Ifyou checked Calculate Vertical llluminance Levels, you will then be prompted to specify on which side of the
line the vertical illuminance levels will be displayed.

Specify side to place vertical illuminance values:

You will then be prompted to insert the calculation schedule, group the calculation line with an area, or press
ENTER to finish the command.

Specify insertion point for calculation schedule or point inside boundary to group with:

Insert a Calculation Schedule: To insert a calculation schedule, select a point on the drawing that is not
inside of a calculation area. A calculation schedule will be inserted at the point specified.

Group with an Area: To group the line with an area, select a point on the drawing that is inside ofa
calculation area. The two will be grouped. If the selected calculation area already has a calculation schedule
on the drawing, it will be used as the calculation schedule for the group. If it does not have a calculation
schedule, no calculation schedule will be used for the group.

Finish the Command: Press ENTER to finish the command without inserting a calculation schedule or

grouping the calculation line with an area. No calculation schedule will be inserted and the calculation line
will be in its own separate group.

Related Options

Schedule title justification: Sets the justification for the schedule title.

Schedule column label justification: Sets the justification for column headings.

Schedule title continued label: Sets the label added to the schedule title for continued sections.

Default grid spacing: Sets the default value for the l/luminance Level Spacing setting.

Insert Sloped Calculation Line

The Insert Sloped Calculation Line command is used to insert a sloped line on the drawing where
illuminance levels are to be calculated.

To insert a sloped calculation line on the drawing, go to

Ribbon: pM Photometrics->Calculation Areas-> Ii. Insert Sloped Line

Pulldown Menu: DM Photometrics->Insert Sloped Calculation Line

Insert Sloped Calculation Line Dialog Box
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Insert Sloped Calculation Line x
[ ] Owvenide Schedule Title
GENERAL PHOTOMETRIC SCHEDLULE |

Horzontal Calculations

lluminance Level Spacing ft4n): |'|D |

Top Eevation ft4in): |'||3' |

Bottom Elevation ft-in): |D |

Wertical Calculations

[ ] Calculate Vertical lluminance Levels

E |

(==

Cancel

Override Schedule Title: Whether the schedule title for the current calculation area is to be changed fromthe
default calculation schedule title.

Schedule Title: The title to be used in the calculation schedule for the calculation area. This field is enabled if the
Override Schedule Title boxis checked.

Grid/ Illuminance Level Spacing: The distance between points where illuminance levels will be calculated.
Top Flevation: The elevation at the top of the slope.
Bottom Elevation: The elevation at the bottom of the slope.

Calculate Vertical lluminance Levels At Area Boundary: Whether vertical illuminance levels are to be
calculated along the line.

Vertical Calculation Spacing: The distance between points where vertical illuminance levels will be calculated.
Vertical Display Spacing: The distance between vertical calculation points as they are displayed on the drawing.

Ending Vertical Calculation Flevation Above Slope: The maximum vertical distance at which vertical illuminance
levels will be calculated along each point on the slope. For example, a line with a Top Elevation of 30 and an
Ending Vertical Calculation Elevation Above Slope of 10 will calculate illuminance levels from 30' to 40" at the
top of'the slope.

Inserting the Sloped Calculation Line on the Drawing

To insert the calculation line on the drawing, press the OK button. The settings you specified in the dialog box
will be used for the line.
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You will be prompted to specify a point that is at the top elevation.

Specify top of calculation line:

You will then be prompted to specify a point that is at the bottom elevation.
Specify bottom of calculation line:

The line will be thicker at the higher elevation to help you visualize how it slopes.

Ifyou checked Calculate Vertical llluminance Levels, you will then be prompted to specify on which side of the
line the vertical illuminance levels will be displayed.

Specify side to place vertical illuminance values:

You will then be prompted to insert the calculation schedule, group the calculation line with an area, or press
ENTER to finish the command.

Specify insertion point for calculation schedule or point inside boundary to group with:

Insert a Calculation Schedule: To insert a calculation schedule, select a point on the drawing that is not
inside of a calculation area. A calculation schedule will be inserted at the point specified.

Group with an Area: To group the line with an area, select a point on the drawing that is inside ofa
calculation area. The two will be grouped. If the selected calculation area already has a calculation schedule
on the drawing, it will be used as the calculation schedule for the group. If it does not have a calculation
schedule, no calculation schedule will be used for the group.

Finish the Command: Press ENTER to finish the command without inserting a calculation schedule or

grouping the calculation line with an area. No calculation schedule will be inserted and the calculation line
will be in its own separate group.

Related Options

Schedule title justification: Sets the justification for the schedule title.

Schedule column label justification: Sets the justification for column headings.

Schedule title continued label: Sets the label added to the schedule title for continued sections.

Default grid spacing: Sets the default value for the //luminance Level Spacing setting.

Insert Mask

The Insert Mask command is used to define an area in a calculation area where the illuminance values should
not be calculated.

To insert a mask on the drawing, go to

Ribbon: pM Photometrics->Calculation Areas-> I:‘ Mask
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Pulldown Menu: DM Photometrics->Insert Mask
You will be prompted to specify the starting point of the mask.

Specify points for mask:
Specify start point:

You will then be prompted to specify the next point of the mask.
Specify next point:

You can specify additional points or press ENTER to complete the mask. The mask will be displayed on the
drawing. The illuminance levels inside the area will not be calculated or displayed.

Calculation Area Groups

Multiple calculation areas can be joined together in a single calculation area group. Grouped areas share a
common calculation schedule. The calculated values in the schedule will include the illuminance values in all of
the areas in the group.

Add Calculation Area to Group

The Add Calculation Area to Group command is used to group multiple calculation areas together.
Calculations areas in a group share a common calculation schedule.

To add a calculation area to a calculation area group, go to

Ribbon: DM Photometrics->Calculation Areas-> M‘ Add to Group
Pulldown Menu: DM Photometrics->Calculation Area Groups->Add Calculation Area to Group

You will be prompted to identify a calculation area in the group to which you want to add another calculation
area.

Select calculation boundary:
You will then be prompted to identify a calculation area to be added to the group.
Select boundary to group with the first boundary:

The second calculation area will be added to the same group as the first calculation area. If the second calculation
area was in another group, it will be removed fromthe group but all of the other areas in the group will remain. If
the second area had a calculation schedule inserted on the drawing, it will be erased. The calculation schedule for
the group will include the illuminance values fromthe second area.

Remove Calculation Area from Group

The Remove Calculation Area from Group command is used to remove a calculation area froma calculation
area group.

To remove a calculation area froma calculation area group, go to
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Ribbon: DM Photometrics->Calculation Areas-> ! Remove from Group

Pulldown Menu: DM Photometrics->Calculation Area Groups->Remove Calculation Area from
Group

You will be prompted to identify which calculation area is to be removed froma calculation area group.

Select calculation boundary:

The calculation area will be removed fromthe group.

You will then be prompted for the insertion point for the calculation schedule for the selected area.

Specify insertion point for calculation schedule:

Specify an insertion point to insert the calculation schedule at that point, or press ENTER to finish the command.

Highlight Calculation Area Group

The Highlight Calculation Area Group command is used to highlight all of the calculation areas in a
calculation area group.

To highlight grouped calculation areas on the drawing, go to

Ribbon: DM Photometrics->Calculation Areas-> Highlight Group

Pulldown Menu: DM Photometrics->Calculation Area Groups->Highlight Calculation Area
Group

You will be prompted to identify a grouped calculation area to highlight.

Select calculation boundary:

All of the calculation areas that are grouped with the selected calculation area will be highlighted on the drawing.
To remove the highlights, use the standard CAD REGEN command.

Calculation Schedules

Each calculation area or calculation area group can have a calculation schedule associated with it. This schedule
displays the illuminance levels and uniformity ratios for the area or group.

Add Calculation Schedule

To add a calculation schedule to a calculation area, go to

. 0
Ribbon: DM Photometrics->Calculation Areas-> Add Calculation Schedule

Pulldown Menu: DM Photometrics->Calculation Schedules->Add Calculation Schedule
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You will be prompted to identify the calculation area to which you want to add a photometric calculation
schedule.

Select boundary to add schedule to:

You will then be prompted for the insertion location of the photometric calculation schedule.

Specify insertion point for calculation schedule:

The location you specify will be used as the top-left corner for the photometric calculation schedule.

If a calculation schedule for the area already exists on the drawing, it will be moved to the new location specified.

See the Edit Calculation Schedule Layout section for more information about editing the calculation schedule
layout.

Related Options

Schedule title justification: Sets the justification for the schedule title.
Schedule column label justification: Sets the justification for column headings.

Schedule title continued label: Sets the label added to the schedule title for continued sections.

Delete Calculation Schedule

To delete a photometric calculation schedule from the drawing, go to

Ribbon: DM Photometrics->Calculation Areas-> E& Delete Calculation Schedule

Pulldown Menu: DM Photometrics->Calculation Schedules->Delete Photometric Calculation
Schedule

You will be prompted to identify which photometric calculation schedule is to be deleted.
Select schedule to delete:

The photometric calculation schedule will be removed from the drawing.

Edit Calculation Schedule Note

To edit a calculation schedule note, go to

Ribbon: DM Photometrics->Calculation Areas-> Eﬁ Edit Calculation Schedule Note
Pulldown Menu: DM Photometrics->Calculation Schedules->Edit Calculation Schedule Note

You will be prompted to specify the calculation area or schedule for which the schedule note is to be edited.
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Select boundary or schedule to add note to:

The Edit Photometric Schedule Note dialog box will appear.

Edit Photometric Schedule Note Dialog Box

Edit Photometric Schedule Mote >

Schedule Note: | Edit. . .

Cancel

Schedule Note: This note is displayed below the photometric schedule on the drawing.
Press the OKbutton to close the dialog box The note at the bottom of the calculation schedule will be updated.

Solids

This section describes how to use solids. Solids represent items on the drawing that will block light, such as
buildings.

Common Solids Information

The values that can be specified for a solid are listed below.
Starting Elevation: The starting elevation of the solid.
Ifthis is 0 and the object is a closed area, no values inside the object will be calculated or displayed.

Ifthis is greater than 0, the light levels underneath the object will be calculated. This setting can be used to model
overhangs.

Ending Hevation: The ending elevation of the solid.
If this elevation is lower than the elevation of a light fixture, some light will pass over the object.

Reflectance: The percentage of light reflected by the solid. It is only used if reflections are enabled in the
Calculate dialog box.

Insert Solid: Shape

The Insert Solid: Shape command is used to insert solids that are closed but not rectangular. If the Starting
Elevation is 0, any illuminance levels inside the shape will not be printed. Most solid objects will be inserted
using this command, as most buildings and other objects on your plans will require a non-rectangular shape.

To define a solid shape, go to

Ribbon: DM Photometrics->Solids-> @ Shape
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Pulldown Menu: DM Photometrics->Insert Solid: Shape

Insert Solid: Shape Dialog Box

Insert Solid: Shape et

Starting Elevation ft4n): D
Ending Blevation {ft4n):
Reflectance:

Cancel

See the Common Solids Information section for more information about the values in this dialog box.

Enter the relevant information into the dialog boxand press the OK button.You will be prompted to draw the solid
shape on the drawing.

Specify first point of solid shape:
You will then be prompted to specify the next point of the solid.
Specify next point:

You can specify additional points or press ENTER to complete the shape. The solid shape will be displayed on the
drawing and included in the photometric calculations.

Insert Solid: Rectangle

The Insert Solid: Rectangle command is used to insert solid objects that are rectangular. These objects are
closed. If theStarting Elevation is 0, any illuminance levels inside the rectangle will not be printed.

To define a solid rectangle, go to

Ribbon: DM Photometrics->Solids-> Lo Rectangle

Pulldown Menu: DM Photometrics->Insert Solid: Rectangle

Insert Solid: Rectangle Dialog Box
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Insert Sclid: Rectangle =

Starting Elevation ft4n): D
Ending Elevation ft4n):
Reflectance:

Cancel

See the Common Solids Information section for more information about the values in this dialog box.

Enter the relevant information into the dialog boxand press the OKbutton. You will be prompted to specify the
first corner of the solid rectangle on the drawing.

Specify first corner of solid rectangle:

You will then be prompted to specify the second corner of the solid rectangle.

Specify second corner of solid rectangle:

The solid rectangle will be displayed on the drawing and included in the photometric calculations.

Insert Solid: Line

The Insert Solid: Line command is used to insert solid objects that are shaped like a line. These objects are
not closed.

To define a solid line, go to

Ribbon: DM Photometrics->Solids-> f Line

Pulldown Menu: DM Photometrics->Insert Solid: Line

Insert Solid: Line Dialog Box

Insert Solid: Line >

Starting Elewvation fft-n): D
Ending Elevation fft-in):
Reflectance:

Cancel

See the Common Solids Information section for more information about the values in this dialog box.

Enter the relevant information into the dialog boxand press the OKbutton. You will be prompted to specify the
starting point of the solid line.
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Specify first point of line:
You will then be prompted to specify the ending point of the solid line.
Specify next point:

You can specify additional line points or press ENTER to end the line. The solid line will be displayed on the
drawing and included in the photometric calculations.

Insert Vertex in Area or Solid

The Insert Vertex in Area or Solid command is used to insert a vertexin a calculation area boundary,
solid, or mask on the drawing.

To insert a vertex, go to

Ribbon: pM Photometrics->Solids-> T_ Insert Vertex
Pulldown Menu: DM Photometrics->Insert Vertex in Area or Solid

You will be prompted to identify the location on the area boundary, solid, or mask where you want a vertexto be
added.

Select break point on photometric area, solid, or mask:

A new vertex will be inserted. The appearance of the object will not change, but you will have a new grip that you
can use to drag the object into the correct shape.

Remove Vertex from Area or Solid

The Remove Vertex from Area or Solid command is used to remove a vertex froma calculation area
boundary, solid, or mask on the drawing.

To remove a vertex, go to

Ribbon: DM Photometrics->Solids-> TE Remove Vertex

Pulldown Menu: DM Photometrics->Remove Vertex from Area or Solid
You will be prompted to identify the vertexto be removed.

Select point to remove on photometric area, solid, or mask:

The vertex will be removed.

Layer Management

This section describes the commands available to help you manage your layers. The commands will turn on and
off the construction layers that are typically set to not plot. Turning the layers off will allow you to view the
drawing as it will appear when plotted. Turning the layers on will allow you to continue to work on your design.
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The following items will have their layers modified by these commands:
® (Calculation Areas

Masks

Solids

Light Fixture Overlays

Alignment Points

All of the layers created and used are standard CAD layers and can be managed using standard CAD commands.
These commands are included for your convenience, but are not necessary. Everything you can do with these
commands can be done with standard CAD commands.

These command specifically change the On setting for the layers, toggling them between On and Off. The Freeze
setting for the layers is not changed.

If you run these commands while in a paper space viewport, the VP Freeze setting will be changed also. You can
use this feature to freeze these construction lines in the viewport you will use for plotting, then thaw the layers in
model space.

Turn Construction Layers On

To turn your construction layers on, go to

Ribbon: DM Photometrics->Calculation Areas-> @ On
Pulldown Menu: DM Photometrics->Turn Construction Layers On
The construction layers will be turned on and visible on the drawing.

Turn Construction Layers Off

To turn your construction layers off, go to

Ribbon: pM Photometrics->Calculation Areas-> @ Off

Pulldown Menu: DM Photometrics->Turn Construction Layers Off

The construction layers will be turned off and no longer visible on the drawing.
Utilities

This section describes the utility commands that are available to assist in maintaining the integrity of your project
database and drawings.

Coordinate Drawings and Database

The Coordinate Drawings and Database command is used to compare the project database with one or
more drawings and confirm that the information matches.

To coordinate a set of selected drawings with the database, go to

Ribbon: DM Photometrics->Utilities-> =->Coordinate Drawings and Database
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Pulldown Menu: DM Photometrics->Utilities->Coordinate Drawings and Database

Select Drawings Dialog Box

Select Drawings *
Press CTRL or SHIFT to Select Multiple Drawings
¥R-SITE.DWG

Select Currently Open Drawing

Cancel

Drawing List: Select the drawings you want to coordinate with the database. The current drawing is selected
when the command is first run. Use the SHIFT and CTRL keys to select multiple drawings in the list. All of the
selected drawings will be coordinated with the database.

Select Currently Open Drawing: Press this button to select the current drawing.
Press the OKbutton to coordinate the selected drawings with the database.

The following actions will be performed:
® Devices on the drawing will be added to the database.
® Devices in the database will be added to the drawing. If the command causes a device to be inserted
directly on top of another device, the new device will be inserted at the edge of the drawing. Any devices
inserted fromthe database will have a line drawn to them. Review the newly inserted devices and move,

delete, or otherwise modify themas appropriate. Once they are on the drawing, you can treat them like
standard devices.

® Devices in both the drawing and the database will be reviewed to ensure their locations and settings
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match.
* Any changes to scheduled devices, such as new graphics for a device type, will be made on the drawing.

When this command is finished, the drawing and the database will match. All devices on the drawing will
accurately reflect the information stored in the database.

Devices reinserted on the drawing from the database will be highlighted with lines from the origin to their
insertion point. Review these devices to determine whether they should be kept. Use the standard CAD ERASE
command to remove excess devices fromthe drawing.

The coordination lines can be removed either by using the standard CAD ERASE command and selecting the
coordination lines, or by using the Erase Coordination Lines command.

When to Use the Coordinate Drawings and Database
Command

When you make changes to a drawing, these changes are immediately recorded in the database. Changes are not
recorded on the drawing until it is saved. If your CAD program crashes before the drawing is saved, the database
will have newer and better information than the drawing. Use the Coordinate Drawings and Database
command to match the drawing and database, and you can often recover information that was lost.

Changes to customization settings are not immediately reflected on the drawings. If you change your
customization settings in the middle of a project, use the Coordinate Drawings and Database command to
update the drawings.

There are other times when this command can fixerrors in your project. A backup of the current drawing and
database is made before the command is run in case something unexpected happens during the command.

Erase Coordination Lines
To erase coordination lines generated when using the Coordinate Drawings and Database command, go to
Ribbon: DM Photometrics->Utilities-> ->Erase Coordination Lines
Pulldown Menu: DM Photometrics->Utilities->Erase Coordination Lines
The coordination lines will be erased from the current drawing.
Coordination lines may also be erased using the standard CAD ERASE command.

Check for Drawings to Update

The Check for Drawings to Update command is used to check for and update any drawings that need to
have changes made to them. Certain changes made on one drawing in a project will require changes to be made to
other drawings in the project. Typically, these changes happen automatically.

This command will check for any drawings that need to have changes made and give you a chance to update
themall.

To check if any drawings in the current project need to be updated, go to

Ribbon: DM Photometrics->Utilities-> ->Check for Drawings to Update
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Pulldown Menu: DM Photometrics->Utilities->Check for Drawings to Update

The drawings that need to be updated will be identified. You will be given a chance to update them automatically
if there are any.

Project Explorer

The Project Explorer command lists all of the light fixtures included in the current project, organized by light
fixture type and by drawing.

To view a list of all light fixtures included in the current project, or to find a specific light fixture, go to

Ribbon: DM Photometrics->Utilities-> lE{ Project Explorer

Pulldown Menu: DM Photometrics->Utilities->Project Explorer

Project Explorer Dialog Box
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GM Project Explorer >

Sort Order: Sort by callout, then drawing w Find = | | Query. . .

[+ E-3.1 (OUTDOOR PHOTOMETRICS).DWG

Sort Order: How the list is sorted.

¢ Sort by callout, then drawing: All of the light fixture callouts are listed. Under each callout, all of the drawings
containing light fixtures using that callout are listed. Callouts that do not have light fixtures inserted on a
drawing are listed, but no drawings are listed under them.

® Sort by drawing, then callout: All of the drawings containing light fixtures are listed. Under each drawing, all of
the callouts on that drawing are listed. Callouts that do not have light fixtures inserted on a drawing are not
listed.

ID: A number is displayed for each light fixture. This number is the unique internal identifier used in the project
database for the light fixture. The specific value does not have any meaning other than the fact that it is different
for each light fixture. In general, light fixtures inserted later in the project will have values higher than light fixtures
that are inserted earlier.

Finding a Light Fixture Using the Project Explorer Dialog Box
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Find: Press this button to display the selected light fixture on the drawing. If the light fixture is located on another
drawing, the other drawing will be opened and the light fixture highlighted. A line will be displayed between the
cursor and the light fixture on the drawing to help you locate it.

If a drawing or callout is highlighted in the dialog box when the Find button is pressed, nothing will happen.
You will be prompted at the command line regarding what to do next.
[Query device/Next device/Previous device/<Return to dialog>]:

Query device: The light fixture is queried as if the Query command had been used on it. See the Query
section for more information.

Next device: Locate the next light fixture of the current type.
Previous device: Locate the previous light fixture of the current type.

Return to dialog: Return to the Project Explorer dialog box.

Querying a Light Fixture Using the Project Explorer Dialog Box
Query: Press this button to query a light fixture callout or individual light fixture.

Individual light fixtures are queried as if the guery command had been used. See the Query section for more
information.

Light fixture callouts are queried as ifthe Light Fixture Project Schedule command had been used. See
the Light Fixture Project Schedule section for more information.

Delete Extra Devices from Database

The Delete Extra Devices From Database command is used to delete devices fromthe database that are
on drawings that no longer exist in the project.

Normally, you would use the standard CAD ERASE command to erase devices. They will be erased fromthe
drawing and database.

If a drawing is moved or deleted before all of the devices are erased, the records still exist in the database. You
cannot erase the device fromthe drawing because it no longer exists. Using this command, these devices can be
deleted fromthe database.

To delete any devices that exist in the database that either do not have an associated drawing or are on a drawing
that no longer exists, go to

Ribbon: DM Photometrics->Utilities-> ->Delete Extra Devices From Database
Pulldown Menu: DM Photometrics->Utilities->Delete Extra Devices From Database

The drawing that each device is on will be compared with the list of drawings in the project. If a drawing in the
database does not exist, the Delete devices? dialog box will appear.
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Delete devices? >

Devices were found in the database on drawing E-2.1.2 (15T AND
This drawing does not appear to exist anymaore.
Would you like to permanently delete these devices from the database?

Yes Yes to Al Mo to Al
Yes: Press this button to delete the devices fromthe listed drawing.
Yes to All: Press this button to delete the devices fromall of the drawings that are not found.

No: Press this button to not delete the devices fromthe listed drawing. Use this button if the drawing should exist
and you plan to recreate it.

No to All: Press this button to not delete the devices fromall of the drawings that are not found.

Rename Database

The Rename Database command is used to change the name of the database file associated with the current
drawing. It will change the suffix of the file when viewed in Windows Explorer. Nothing else in the project will be
changed.

To rename the database, go to
Ribbon: DM Photometrics->Utilities-> ->Rename Database

Pulldown Menu: DM Photometrics->Utilities->Rename Database

Rename Photometrics Database Dialog Box

Rename Photometrics Database 4

Project Name: | |
Leave field empty to use default.

Cancel

Project Name: The new name of the database.

Enter the new Project Name and press the OKbutton. The suffix of the database file associated with the current
drawing will be changed. No other changes will be made in the project.

Delete DM Backups Over 30 Days Old

The belete DM Backups Over 30 Days 01d command is used to delete files fromthe DMBackup folder.
Backups are made on a regular basis for projects and when certain utility commands are run. When a project is
opened, any backups over 30 days old are automatically deleted. However, if a project is not opened, backups
over 30 days old will not be deleted.
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This command will erase all of the backups that it finds in any subfolders of the selected folder. If you have a
folder that contains all your projects, you can select the main folder and have all backups fromall projects
deleted.

Backups less than 30 days old will not be deleted. You must use Windows Explorer to delete these folders.
To delete backup files that are over 30 days old, go to
Ribbon: DM Photometrics->Utilities-> ->Delete DM Backups Over 30 Days 01ld

Pulldown Menu: DM Photometrics->Utilities->Delete DM Backups Over 30 Days 0Old

Select Folder Dialog Box

B Select Folder >
Lok in: | | | 13 Final Output v| @ & = @
i Mame Date modified Type
DMBackup 272772019 215 PM File folder

Cuick access

Desktop
| |
Libraries

This PC

¢ ,

Metwaork

Falder name: | C:\UsershK.aneD eskloph TutoralsPhotometrict13 Final Out | | ]

Cancel

Select the folder to delete backups from. All backups over 30 days old will be deleted.

Find Lost Toolbars

The Find Lost Toolbars command is used to move all of the toolbars to a visible location on the screen. If
your CAD programmoves the toolbars to a location that cannot be seen, the toolbars are made unusable. Moving
all of the toolbars is the simplest solution to this problem.

To find lost toolbars, go to

Ribbon: DM Photometrics->Utilities-> ->Find Lost Toolbars
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Pulldown Menu: DM Photometrics->Utilities->Find Lost Toolbars

Once this command is entered, all of the toolbars will be displayed. Move any toolbars you want visible to the
correct location. Close any toolbars that you do not use.

Reload Ribbons

The Reload Ribbons command is used to reload the Design Master Photometrics ribbon tabs. Use this
command if the tabs have disappeared from your ribbon.

To reload the ribbon tabs, go to
Pulldown Menu: DM Photometrics->Utilities->Reload Ribbons
Once this command is run, the ribbon tabs should be reloaded and visible on your ribbon.

Delete Drawing

The Delete Drawing command is used to delete a drawing that contains Design Master Photometrics devices
and remove all of the associated information fromthe database.

If you delete a drawing using Windows Explorer, the database will not be updated. Any devices that existed on
the drawing will still exist in the database. It is possible to delete these devices using the Delete Extra Devices
from Database command, but this method can easily create larger problems.

Deleting the drawing using this command will make sure that the necessary changes to the database are made.

You do not need to use this command if the drawing does not contain Design Master Photometrics devices,
though there is no harmifyou do.

To delete a drawing, go to
Ribbon: DM Photometrics->Utilities-> ->Delete Drawing

Pulldown Menu: DM Photometrics->Utilities->Delete Drawing

Select Drawing to Delete Dialog Box
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B Select Drawing To Delete

Look in: | 13 Final Output

V| @ & = m-

i Mame
DMEBackup

Quick access E-SitE dwg

Date modified Type

2/27/2019 215 PM File folder
8/27/2018 236 PM AutoCAD
ST2018 626 AM AutoCAD

- wr-site.dwg

Desltop

™
Libraries
This PC

* £ >

L! File name: e

Mo | | [Coeen ]
Files of type: DWG Files (" dwg) o Cancel
[ ]0pen as read-only

Select the drawing to delete and press the Open button.
The drawing will be deleted. All of the devices on the drawing will be deleted from the database.

A backup of the drawing and the database will be made before the command is run in case a drawing is deleted
accidentally.

Rename Drawing

The Rename Drawing command is used to rename the current drawing. The database will be updated so that any
devices associated with the drawing will have their drawing location information changed.

If you rename a drawing using Windows Explorer or the standard CAD savEas command, the database does not
know if you intend to copy or rename the drawing. It is very easy to create significant errors in your drawings and
database if you choose the wrong option.

Renaming the drawing using this command will prevent these errors from happening.
To rename the current drawing, go to
Ribbon: DM Photometrics->Utilities-> ->Rename Drawing

Pulldown Menu: DM Photometrics->Utilities->Rename Drawing

Rename Drawing Dialog Box
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Rename Drawing x

Mew Drawing Mame: | |

Cancel

New Drawing Name: The name of the new drawing.

Enter the New Drawing Name into the dialog boxand press the OKbutton. The name of the current drawing will
be changed.

Copy Drawing

The Copy Drawing command is used to copy the current drawing. Copies of all of the devices on the drawing
will be created in the database.

If you copy a drawing using Windows Explorer or the standard CAD saveas command, the database does not
know if you intend to copy or rename the drawing. It is very easy to create significant errors in your drawings and
database if you choose the wrong option.

Copying the drawing using this command will prevent these errors from happening.
To copy the current drawing, go to
Ribbon: pM Photometrics->Utilities-> ->Copy Drawing

Pulldown Menu: DM Photometrics->Utilities->Copy Drawing

Copy Drawing Dialog Box

Copy Drawing x

Mew Drawing Mame: | |

Cancel

New Drawing Name: The name of the new drawing.

Enter the New Drawing Name into the dialog boxand press the OKbutton. A copy of the current drawing will be
made using the new name.

Copy Drawing and Remove Links to
Database

The Copy Drawing and Remove Links to Database command is used to make a copy of a drawing and
remove all of the links between the Design Master Photometrics entities on the drawing and the database. The
appearance of the drawing will not change. All entities on the drawing will remain. However, they will be
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converted to standard CAD entities and their connection to the database will be removed.
To copy a drawing and remove all of the links to the database, go to
Ribbon: DM Photometrics->Utilities-> =->Copy Drawing and Remove Links to Database

Pulldown Menu: DM Photometrics->Utilities->Copy Drawing and Remove Links to Database

Save Drawing as Dialog Box

A Save drawing as x
Save in: | 13 Final Output " | o« W A T
i Mame Date modified Type
_ DMBackup 9/13/2018 812 AM  File folder
e e-site.dwyg /27/20182:36 PM AutoCAD
- wr-site.dwg &/7/2018 26 AM AutoCAD
Desktop
Libraries
This PC
Ld £ >
Metwork
Save as type: DWG Files (".dwag) o Cancel

Select a location for the copy, enter a file name, and press the OKbutton. A copy of the current drawing will be
made using the new name. All of the Design Master Photometrics links to the project database will be removed.

The project database will not be modified during this command.

Copy Drawing and Remove All DM Entities

The Copy Drawing and Remove All DM Entities command is used to make a copy of a drawing with all of
the Design Master Photometrics entities on it erased.

This command is useful when you want to create a new drawing with the same settings as an existing drawing in
the project. Using other methods, the copied drawing will copy the Design Master Photometrics entities. Cleaning
up these extra devices can cause problems if not done correctly. This command will remove all of the devices for
you, leaving you with a new drawing that you can immediately start using.
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To copy a drawing and remove all of the Design Master Photometrics entities, go to
Ribbon: DM Photometrics->Utilities-> ->Copy Drawing and Remove All DM Entities

Pulldown Menu: DM Photometrics->Utilities->Copy Drawing and Remove All DM Entities

Save Drawing as Dialog Box

A Save drawing as x
Save in: | 13 Final Qutput w | (< W i b
: Mame Date modified Type
. DMBackup 9/13/2018 812 AM  File folder
L feziies e-site.dwg 8/27/2018 236 PM  AutoCAD
- ¥r-site.dwg S7/2018 B:26 AM AutoCAD
Desktop
Libraries
This PC
Id £ >
Metwork
File name: ~ | | Save I
Save as type: DWG Files (".dwag) w Cancel

Select a location for the copy, enter a file name, and press the OKbutton. A copy of the current drawing will be
made using the new name. All of the Design Master Photometrics entities on the new drawing will be erased.

The project database will not be modified during this command.

Disconnect Photometrics Database from
Drawing

The Disconnect Photometrics Database from Drawing command is used to remove all of the links
between the Design Master Photometrics entities on the drawing and the database. The appearance of the
drawing will not change. All entities on the drawing will remain. However, they will be converted to standard CAD
entities and their connection to the database will be removed.

To disconnect the database fromthe drawing, go to

Ribbon: DM Photometrics->Utilities-> ->Disconnect Photometrics Database from Drawing
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Pulldown Menu: DM Photometrics->Utilities->Disconnect Photometrics Database from
Drawing

The project database will not be modified during this command.

Copy or Back Up Project

The Copy or Back Up Project command is used to make a complete copy or backup of the current project.
When you copy or back up a project, it is important to copy all of the drawings and the Design Master database
files. This command will copy all of the necessary files. Use this command if you want to make a backup ofthe
current state of the project or if you want to make a copy to try a different design approach.

To copy or back up a project, go to
Ribbon: DM Photometrics->Utilities-> =->Copy or Back Up Project

Pulldown Menu: DM Photometrics->Utilities->Copy or Back Up Project

Select Folder to Copy or Back Up Project To Dialog Box

ﬂ Select Folder to Copy or Back Up Project To x
Lok in: | | | 13 Final Output v| @ & = @

i Mame Date modified Type

DMBackup 1/3/2022 1:31 PM File fo

Chuick access

Desktop

Libraries

w .

Falder narme: e ok

Cancel

Select the folder to copy or back up the project to and press the OK button. All files associated with the project
will be copied and saved to the folder.
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Check In Floating License

The check In Floating License command is used with floating licenses to immediately check in the license
so that another person can use the software. Floating licenses are checked out in 10-minute intervals. If no
commands are run for 10 minutes, the license is automatically released and another person can use the software.

If another person attempts to use the software before the license is released, a warning message will be displayed
for the new user, stating that no license is available. The new user can choose to ignore the warning and
immediately start using the software. However, a license overuse exception will be recorded on the license server.
If there are too many overuse exceptions, you will need to purchase another license.

Using this command, the original user can check in the floating license when they are done with it. The new user
can then use the software immediately without causing a license overuse exception to be recorded.

To check in the floating license, go to

Ribbon: pM Photometrics->Utilities-> ->Check In Floating License
Pulldown Menu: DM Photometrics->Utilities->Check In Floating License
The floating license will be checked in and will be available for another person to use.

Help

This section describes the commands available for obtaining support, maintaining current licenses, and installing
software updates.

Common Help Information

You are prompted to provide the following information when sending us a support request. We use this
information to respond to your support request.

Name: Your name.
Email Address: Your email address. If possible, we will respond to your support request by email.

Phone Number: Your phone number. If we need additional information beyond what we can gather by email, we
will call you.

Additional Information: A description of the problem you are having. The more information you can provide
about your problem, the more likely we will be able to solve it for you. For example, specific devices that exhibit
the problem you are having.

Your Design Master Photometrics version, CAD program version, and Windows version will be sent
automatically with the support request. You do not need to include that information here.

User Manual

To open the Design Master Photometrics User Manual (which you are currently viewing), go to

Ribbon: DM Photometrics->Utilities-> ->User Manual
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Pulldown Menu: DM Photometrics->Help->User Manual

The user manual will be opened in your web browser.
Tutorial

To open the Design Master Photometrics Tutorial, go to

Ribbon: DM Photometrics->Utilities-> ->Tutorial

Pulldown Menu: DM Photometrics->Help->Tutorial

The tutorial will be opened in your web browser. The tutorial provides instructions for and examples of common
tasks that can be performed using our software.

Remote Support

The Remote Support command allows us to connect to your computer over the internet. We will be able to see
your screen and performactions on your computer.

To allow us to connect to your computer, go to

Ribbon: DM Photometrics->Utilities-> ->Remote Support
Pulldown Menu: DM Photometrics->Help->Remote Support

The remote support program will run and allow us to connect to your computer.

An ID number will be displayed, which you will need to read aloud to us.

We use TeamViewer for our remote support. You can visit their website at http://www.teamviewer.com.

Information about security is available at http://www.teamviewer.com/en/products/security.aspx.

Send Project to Design Master Support

The send Project to Design Master Support command is used to send us the current drawing and the
associated Design Master Photometrics database. Providing us with your project helps us recreate the problem
you are having and find a solution to it. It is our preferred way for you to report a problemor ask a question.
Many problems are specific to a project and having that immediately helps us assist you.

To send a copy of your project's current drawing and database to us, go to
Ribbon: DM Photometrics->Utilities-> ->Send Project to Design Master Support

Pulldown Menu: DM Photometrics->Help->Send Project to Design Master Support

Send Project to Design Master Support Dialog Box
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BM Send Project to Design Master Support >

To:
Design Master Support (support@designmaster. biz)

From:

MName: | |

Email Address (required): | |

Re-enter Email Address: | |

Phane Mumber: | |

Additional Information:

Attachments. . . 13 Files)

[ ]save to desktop (check if sending fails or crashes)

Cancel

See the Common Help Information section for more information about the Name, Email Address, Phone Number
and Additional Information fields.

Attachments: Press this button to change the files that will be sent with the support request.

The Design Master Attachments dialog box will appear.
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Design Master Attachments >

C:\UsersKane\Desktop\Tutorial\400watt. ies
C:\Usersiane\Desktop\Tutorial\dm_elec.dm
C:\UsersiKane\Desktop\Tutorial\E-2, 1,2 (15T AMD 2ND FLOOR POWER), DWW

Add

Remove

Corcel

By default, the current drawing and associated Design Master Photometrics database will be included in the
list of files to send.

Add: Press this button to select additional files to send.

Remove: Press this button to remove the selected file fromthe list to send.
Save to desktop: Whether the support request is sent directly to us or saved to your desktop for you to email.
By default, this boxis not checked. Support requests are automatically sent with no further input fromyou.

Some companies block outgoing messages from programs other than your email client. When this happens, you
will be given a chance to save a ZIP file to your desktop that you can send to us manually. Detecting this
configuration can take a long time.

When this boxis checked, the attempt to send the message directly is skipped and you are immediately prompted
to save a ZIP file to your desktop. Skipping the attempt to send saves time.

Go to Design Master Support Website
To open the Design Master Support Website, go to
Ribbon: DM Photometrics->Utilities-> =->Go to Design Master Support Website
Pulldown Menu: DM Photometrics->Help->Go to Design Master Support Website

The support page will be opened in your web browser. This page has useful links and information to help you
when you have trouble with our software.

Send Email to Design Master Support

To send an email to us, go to

Ribbon: DM Photometrics->Utilities-> ->Send Email to Design Master Support
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Pulldown Menu: DM Photometrics->Help->Send Email to Design Master Support

A draft email addressed to support@designmaster.biz will be opened in your preferred email client. Enter your
message and send the email.

Send Master and Standards Databases to
Design Master Support

The send Master and Standards Databases to Design Master Support command is used to send us
your master and standards customization database files. We will occasionally ask for these files when helping
you solve problems related to your customization.

To send a copy of your master and standards databases to us, go to

Ribbon: DM Photometrics->Utilities-> ->Send Master and Standards Databases to Design
Master Support

Pulldown Menu: DM Photometrics->Help->Send Master and Standards Databases to Design
Master Support

Send Master and Standards Databases to Design Master
Support Dialog Box
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GM Send Master and Standards Databases to Design Master Support .y

To:
Design Master Support (support@designmaster. biz)

Fraom:

MName: | |

Email Address (required): | |

Re-enter Email Address: | |

Phaone Mumber: | |

Additional Information:

Attachments. . .

[ ]save to desktop (check if sending fails or crashes)

Cancel

See the Common Help Information section for more information about the Name, Email Address, Phone Number
and Additional Information fields.

Your master database and all of your standards databases will be sent.
Save to desktop: Whether the support request is sent directly to us or saved to your desktop for you to email.
By default, this boxis not checked. Support requests are automatically sent with no further input fromyou.

Some companies block outgoing messages from programs other than your email client. When this happens, you
will be given a chance to save a ZIP file to your desktop that you can send to us manually. Detecting this
configuration can take a long time.

When this boxis checked, the attempt to send the message directly is skipped and you are immediately prompted
to save a ZIP file to your desktop. Skipping the attempt to send saves time.

Set Email Address

The set Email Address command is used to set your default email address and other contact information used
when sending support cases to us.
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To set your default contact information, go to
Ribbon: DM Photometrics->Utilities-> ->Set Email Address

Pulldown Menu: DM Photometrics->Help->Set Email Address

Update Contact Information Dialog Box

Update Contact Information >

Mame: | |

Email Address: | |

Phone Mumber: | |

Cancel

See the Common Help Information section for more information about the Name, Email Address and Phone
Number fields.

Installation Settings

The Installation Settings command is used to display the current installation settings. It can be used to
verify the installation settings are correct, and modify them if necessary.

To view and modify the installation settings, go to
Ribbon: DM Photometrics->Utilities-> ->Installation Settings
Pulldown Menu: DM Photometrics->Help->Installation Settings

There are three different installation types.

Local

A local install should be used when there is only one person using Design Master Photometrics in your office.
All program and customization files are stored directly on the computer. This install type should be used even if
the one person is installing the software on a laptop.

See the Local Install section for more information about this install type.

Network

A network install should be used when there are multiple people using Design Master Photometrics in your
office. The program files are stored on the computer and are automatically updated from the network. The
customization files are stored on the network and are shared between users.

See the Network Install section for more information about this install type.
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Network Laptop

A network laptop install should be used if the computer is a laptop and multiple people are using Design Master
Photometrics in your office. The program files are stored on the laptop and are automatically updated fromthe
network. The customization files are stored on both the network and the laptop. The network customization files
will be used when the laptop is connected to the network. The local customization files will be used when the
laptop is away fromthe office and disconnected from the network.

See the Network Laptop Install section for more information about this install type.

The local customization will automatically be updated with any changes to the network customization once a day.
Use the Update Laptop Customization command to manually update the customization stored on the
computer. See the Update Laptop Customization section for more information.

Local Install

This section describes configuring Design Master Photometrics for a local install. A local install should be used
when there is only one person using Design Master Photometrics in your office. All program and customization
files are stored directly on the computer. This install type should be used even if the person is installing the
software on a laptop.

If you have floating licenses, this install type should not be used.

Configuring an Installation on a Local Computer

Design Master Photometrics Install Configuration x
Install Type
(® Local () Metwork () Network Laptop

Folder Locations

Install Folder: Cpen. . .

Customization Folder: Select Customization Folder. . . Reset Cpen. ..

[/] Mlert me when updates are available

Cancel

Install Type: The type of installation. The dialog box will change depending upon the type selected.
® Local: The installation type described in this section.
® Network: See the Network Install section for more information about this install type.
e Network Laptop: See the Network Laptop Install section for more information about this install type.

Install Folder: The folder where Design Master Photometrics is installed. This folder is forced to be located in
your Application Data folder.

Customization Folder: The folder where the customization files are stored.
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Select Customization Folder: Press this button to select a new location for the customization folder.

Reset: Press this button to reset the customization to the default location, located in your Application Data
folder.

Open: There are two Open buttons in the dialog box. Press this button to open Windows Explorer to one of the
folders listed in the dialog box. The first button opens the install folder. The second button opens the
customization folder.

Alert me when updates are available: Whether updates are checked for automatically. If this is checked, an
update check will occur the first time you run a command each day. An alert will appear if an update is available.

Network Install

This section describes configuring Design Master Photometrics for a network install. A network install should be
used when there are multiple people using Design Master Photometrics in your office. The program files are
stored on the computer and are automatically updated fromthe network. The customization files are stored on the
network and are shared between users.

Configuring an Installation on a Network

Design Master Photometrics Install Configuration >
Install Type
() Local (®) Network () Network Laptop

Folder Locations

Local Install Folder: Cpen. ..
Metwork Install Folder: Select Metwork Install Folder. . . COpen. ..
Customization Folder: Select Customization Falder. . . Cpen. .

Alert me when updates are available

Cancel

Install Type: The type of installation. The dialog box will change depending upon the type selected.
® Local: See the Local Install section for more information about this install type.
e Network: The installation type described in this section.
® Network Laptop: See the Network Laptop Install section for more information about this install type.

Local Install Folder: The folder on the local computer where Design Master Photometrics is installed. This folder
is forced to be located in your Application Data folder.

Network Install Folder: The folder on the network where Design Master Photometrics is installed. This folder
should be on the network. All computers in your office should use the same network install folder.
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Updates should be installed to this folder. Updates to this folder will automatically be copied to the local install
folder.

Customization Folder: The folder where the customization files are stored. This folder should be on the network.
All computers in your office should use the same customization folder.

Select Customization Folder: Press this button to select a new location for the customization folder.

Open: There are three Open buttons in the dialog box. Press this button to open Windows Explorer to one of the
folders listed in the dialog box. The first button opens the local install folder. The second button opens the local
install folder. The third button opens the customization folder.

Alert me when updates are available: Whether updates are checked for automatically. If this is checked, an
update check will occur the first time you run a command each day. An alert will appear if an update is available.

Laptop Install

This section describes configuring Design Master Photometrics for a network laptop install. A network laptop
install should be used if the computer is a laptop and multiple people are using Design Master Photometrics in
your office. The program files are stored on the laptop and are automatically updated from the network. The
customization files are stored on both the network and the laptop. The network customization files will be used
when the laptop is connected to the network. The local customization files will be used when the laptop is away
fromthe office and disconnected fromthe network.

Configuring an Installation on a Laptop

Design Master Photometrics Install Configuration X
Install Type
() Local () Metwork (®) Network Laptop

Folder Locations

Local Install Folder: Cpen. ..
MNetwork Install Folder: Select Network Install Folder. . . COpen. ..
Local Customization Folder: Select Local Customization Folder. . . Reset Open. .
MNetwork Customization Folder: Select Metwork Customization Folder. . COpen. ..

[+] Mlert me when updates are available

Cancel

Install Type: The type of installation. The dialog box will change depending upon the type selected.
® Local: See the Local Install section for more information about this install type.
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® Network: See the Network Install section for more information about this install type.
® Network Laptop: The installation type described in this section.

Local Install Folder: The folder on the local computer where Design Master Photometrics is installed. This folder
is forced to be located in your Application Data folder.

Network Install Folder: The folder on the network where Design Master Photometrics is installed. This folder
should be on the network. All computers in your office should use the same network install folder.

Updates should be installed to this folder. Updates to this folder will automatically be copied to the local install
folder.

Local Customization Folder: The folder where the local customization files are stored. This customization folder
is used if a network connection is not available.

Select Local Customization Folder: Press this button to select a new location for the customization folder.

Reset: Press this button to reset the customization to the default location, located in your Application Data
folder.

Network Customization Folder: The folder where the customization files are stored. This folder should be on the
network. All computers in your office should use the same customization folder.

This folder is used when the computer is connected to the network. The files in this folder are copied to the local
customization folder once each day.

Select Network Customization Folder: Press this button to select a new location for the customization folder.

Open: There are four Open buttons in the dialog box. Press this button to open Windows Explorer to one of the
folders listed in the dialog box. The first button opens the local install folder. The second button opens the local
install folder. The third button opens the local customization folder. The fourth button opens the network
customization folder.

Alert me when updates are available: Whether updates are checked for automatically. If this is checked, an
update check will occur the first time you run a command each day. An alert will appear if an update is available.

Update Local Install from Network

The Update Local Install from Network command is used to update the program files on your computer
from the program files on the network if you have a network install or network laptop install.

This process should take place automatically. Only use this command if there is a problem.

To update the local install from the network, go to

Ribbon: DM Photometrics->Utilities-> ->Update Local Install from Network
Pulldown Menu: DM Photometrics->Help->Update Local Install from Network

The program files on your computer will be updated.
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Check for Updates

The check for Updates command compares the version of Design Master Photometrics you have installed
with the latest version that is available on our website. You will be given instructions for installing a newer
version if one is available.

To check for updates, go to
Ribbon: DM Photometrics->Utilities-> =->Check for Updates
Pulldown Menu: DM Photometrics->Help->Check for Updates

The dialog box that appears depends upon whether an update is available from our website.

Update Not Available

If an update is not available on our website, the following dialog box will appear.

Design Master Photormetrics X

You are uging the most cument version of Design Master Photometrics.
Cument Version: ABC (DEF)

[ ] Alert me when updates are available

Current Version: The current version of the software. ABC will be replaced with the release number. DEF will be
replaced with the build number.

Alert me when updates are available: Whether updates are checked for automatically. If this is checked, an
update check will occur the first time you run a command each day. An alert will appear if an update is available.

Update Available

Ifthe versions are different, you will be prompted to install the latest version.

Design Master Photometrics x

A newer version of Design Master Photometrics is available.

Mew Version: JKL (MNO) PAQ/R
Curment Yersion: ABC (DEF). released G/H/|

I Go to update web page.

Remind me again in a week. Remind me tomaormow . Don't remind me about this update again.

[] Alert me when updates are available
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New Version: The new version of the software available from our website. JKL will be replaced with the new
release number. MNO will be replaced with the new build number. P/Q/R is the date the new version was
released.

Current Version: The current version of the software. ABC will be replaced with the currently installed release
number. DEF will be replaced with the currently installed build number. G/H/Lis the date the currently installed
version was released.

Go to update web page: Press this button to go to a page on our website about the new release. The page will
include a list of new features, install instructions, and a download link.

Remind me again in a week: Press this button to close the dialog box. You will be reminded about the new
version again in one week.

Remind me tomorrow: Press this button to close the dialog box. You will be reminded about the new version
again tomorrow.

Don't remind me about this update again: Press this button to close the dialog box. You will not be reminded
about the new version again.

Alert me when updates are available: Whether updates are checked for automatically. If this is checked, an
update check will occur the first time you run a command each day. An alert will appear if an update is available.

Install Patch

The Install Patch command is used to install patches we send to you. These patches will be ZIP files sent in
response to crash reports or support requests. We send patches to specific users to solve problems they are
currently having. They are not posted to our website.

We regularly release updated versions of Design Master Photometrics that include all of the patches we sent to
customers. These updates are available from our website. You do not need to use this command to install these
updates.

Once you have installed a patch, you will not need to install it again. All future patches or updates you receive
will include the patch.

To install a software patch, go to
Ribbon: DM Photometrics->Utilities-> ->Install Patch

Pulldown Menu: DM Photometrics->Help->Install Patch

Select Patch File Dialog Box
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B Select Patch File b4

Look in: |- Desktop V| (€] ¥ £ -

i Mame Date modified Type

Cuick access

Desltop
[ |
Libraries

L2

This PC
< >

@ -

Metwork
Files of type: ZIP Files {* zip) o Cancel
[ ]0pen as read-only

Select the patch ZIP file and press the Open button. The patch will be installed on your computer. If you have a
network install, it will also be installed on the network. Installing it to the network will update all of the other
computers in your office.

The patch file will be erased after it is installed. It is erased to discourage you frominstalling it again in the future.

Restart your CAD program after installing the patch. The error you were seeing should now be resolved.

Install License

The Install License command is used to activate the license for Design Master Photometrics.
To activate a license, go to
Ribbon: DM Photometrics->Utilities-> ->Install License

Pulldown Menu: DM Photometrics->Help->Install License

Install Design Master Photometrics License Dialog Box
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GM Install Design Master Photometrics License >

License expires on
Enter your license ID in the box below and press the "Activate” button.

Mame:

Email Address:

License |D:

Activation Password (Leave blank if you do not have one):

Activate Cancel

Enter your Name, Email Address, License ID, and Activation Password in the fields provided. If you did not
receive a password, leave the Activation Password field blank.

Press the Activate button to activate your license.
Buy Now
If you are currently using the Design Master Photometrics trial and want to purchase the software, go to
Ribbon: pM Photometrics->Utilities-> ® ->Buy Now
Pulldown Menu: DM Photometrics->Help->Buy Now
The Design Master Photometrics purchase page on our website will open in your preferred browser.
See the Purchasing section for more information about the purchase options available.
About
To view general information about the Design Master Photometrics software, go to
Ribbon: DM Photometrics->Utilities-> ->About
Pulldown Menu: DM Photometrics->Help->About
A dialog box will appear that includes the version of software you are running and your current license status.

Customization

Enter topic text here.This section describes the commands available to customize the software. A wide variety of
customization options are included to allow you to match the drawings that are created to your existing company
standards.
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General Customization Commands

Most of the customization sections include four commands:
® Edit Project List
® Edit Master List OrEdit Standards List
® Copy Project List to Master OrCopy Project List to Standards
® Copy Master List to Project OrCopy Standards List to Project

The command name and how it functions varies slightly depending upon whether the default settings are stored
in the master database or a standards database.

This section describes these general commands and how they work for the customization commands.

Edit Project List

The Edit Project List command is the first command listed in each customization section. It is used to
modify the customization settings in the current project database. It allows you to make changes to a specific
project without affecting other projects.

Edit Master List

The Edit Master List command is one ofthe commands that may be listed second in each customization
section. It is used to modify the customization settings in the master database. These settings will be used when
you start a new project. Changes here do not affect any projects already created.

Edit Standards List

The Edit Standards List command is one ofthe commands that may be listed second in each customization
section. It is used to modify the customization settings in a standards database. These settings can be used when
you start a new project. Changes here do not affect any projects already created.

If only one standards database exists, the command will immediately start editing that database using the
appropriate dialog box.

If more than one standards database exists, you will be prompted to select the standards database to edit. After
you select the standards database to edit, the appropriate dialog box will appear with the settings fromthat
standards database displayed.

Copy Project List to Master

The Copy Project List to Master command will copy the settings fromthe project database to the master
database. Often, it is simplest to start your first project and customize it as you go. When you are finished, you
can use this command to copy the settings for use with future projects.

The Copy Project to Master dialog box will appear.

88



Copy Project to Master >

Do you want to copy the light fixture blocks from this project to the
master database?
Type MASTER. in the box below and press OK to continue,

]

K Cancel

To copy the settings, type MASTER and press the OKbutton. This step helps prevent you from accidentally
overwriting the settings in your master database.

Copy Project List to Standards

The Copy Project List to Standards command will copy the settings fromthe project database to a
standards database. Often, it is simplest to start your first project and customize it as you go. When you are
finished, you can use this command to copy the settings for use with future projects.

If only one standards database exists, the settings will be copied to that standards database. The Copy Project to
Standards dialog box will appear immediately.

If more than one standards database exists, you will be prompted to select a standards database to which the
settings will be copied. After you make your selection, the Copy Project to Standards dialog box will appear.

Copy Project to Standards x

Do you want to copy the options from this project to the standard database?
Type STANDARD in the box below and press OF to continue.

To copy the settings, type STANDARD and press the OKbutton. This step helps prevent you from accidentally
overwriting the settings in your standards database.

Copy Master List to Project

The Copy Master List to Project command will copy the settings fromthe master database to the project
database. You can use this to update projects you have already started with new settings you have set in your
master database.

Copy Standards List to Project

The Copy Standards List to Project command will copy the settings froma standards database to the
project database. You can use this to update projects you have already started with new settings you have set in
your standards database.
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If only one standards database exists, the settings will be copied from that standards database.

If more than one standards database exists, you will be prompted to select the standards database from which the
settings will be copied.

User Options

The user Options command allows you to customize settings that are specific to you. These settings are stored
on your computer. They are not stored in the project, master, or standards database. Some of these settings are
shared with other Design Master programs you have installed on your computer.

To update your user settings, go to

Ribbon: DM Photo: Customization->User Customization-> @ User Options

Pulldown Menu: DM Photometrics->Customization->User Options

Design Master User Settings Dialog Box

T Design Master User Settings >

Mame

B User Support Information

Phone
Save support emnails to the desktop (set to "Yes" if sending fails or crashes) Mo

B Drawing Options

Zoom to schedule after insertion Mo
Automatically open drawings that need to be updated Mo
Alert me when updates are available Yes
Recalculate illuminance levels after query Yes

Cancel

The Design Master User Settings dialog box contains a list of all of the user options and their current settings.
The options are arranged in groups in the list. The groups are described in the sections below:

e User Support Information

* Drawing Options
® Photometrics

Editing a Setting
To edit an option setting, select the Value in the list and enter a new value.
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Press the OK button to save your changes.

User Support Information

This section describes the options available in the User Support Information group in the Design Master User

Settings dialog box.
GM Design Master User Settings pod
Mame Value
& User Support Information
e Marme
..... Emall
Phone

Save support emails to the desktop (set to "Yes" if sending fails or crashes)  No
Drawing Options

Photometrics

ok | | cancel

Name: Your name.
Email: Your email address. This is the email address we will use when replying to support requests fromyou.

Phone: Your phone number. This phone number will be sent with any support requests you send. It is not a
required field, but having it in the support requests helps us call you if we need additional information.

Save support emails to the desktop (set to ""Yes" if sending fails or crashes): Support requests and bug reports
can be emailed directly from Design Master Photometrics. Some company's networks disable this ability, causing
the send to fail or crash. When this happens, the information is saved to a file on your desktop that you can email
to us manually.
® Yes: Design Master Photometrics does not attempt to send the email directly to us. Instead, it saves it to
the desktop. Choose this setting if you consistently have trouble sending us support emails through our
software. Determining that the send step will fail can take time. When you know it will fail, skipping it will
save you time.
® No: Design Master Photometrics will attempt to send the email directly to us. When possible, this is the
setting you should use.

Drawing Options

This section describes the options available in the Drawing Options group in the Design Master User Settings
dialog box.
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oM Design Master User Settings

Value

Mame

User Support Information
‘ Zoom to schedule after insertion Mo

Automatically open drawings that need to be updated

Photometrics

Zoom to schedule after insertion: After you insert a schedule on the drawing, you can specify whether the
drawing should zoomto the schedule or remain at the same location.

® Yes: The drawing will zoomto the schedule after it has been inserted.

® No: The drawing will remain at the same location after a schedule is inserted.

Automatically open drawings that need to be updated: Design Master Photometrics projects can span multiple
drawings. Changes in one drawing can require that changes be made in another drawing. In order to make the

changes in the other drawing, it must be opened.
® Yes: When a change in another drawing is required, the other drawing will be opened. This will take a
moment, but when it is finished, the current drawing will remain active. If the other drawing is already

open, nothing will happen.
® No: When a change in another drawing is required, you will be alerted at the command line, but it will not
automatically be opened. The alert will continue to appear at the command line until you manually open

the drawing and it is updated.

Photometrics

This section describes the options available in the Photometrics group in the Design Master User Settings
dialog box.
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T Design Master User Settings x

Mame Yalue

User Support Information

Drawing Options

= Photometrics

~ Alert me when updates are available
Recalculate illuminance levels after query

Alert me when updates are available: Whether updates are checked for automatically. If this is checked, an
update check will occur the first time you run a command each day. An alert will appear if an update is available.

Recalculate illuminance levels after query: Whether a calculation area or line modified using the Query
command will be recalculated when you press the OK button.

Options

The options commands allow you to customize a variety of settings that affect the calculations in your project
and appearance of your drawings.

See the General Customization Commands section for more information about how the Edit Project List,
Edit Standards List,Copy Project List to Standards,and Copy Standards List to Project
commands work.

To edit the options project list, go to

Ribbon: DM Photo: Customization->Project Customization-> Options

Pulldown Menu: DM Photometrics->Customization->Options->Edit Project List

To edit the options standards list, go to

Ribbon: DM Photo: Customization->Master & Standards Customization-> % Options

Pulldown Menu: DM Photometrics->Customization->Options->Edit Standards List

Design Master Photometrics Options Dialog Box
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GM Design Master Photormetrics Options >

Project is metric Mo
Distance unit Inch
Numinance unit Foot-candle

B Light Fixtures
Insert callout as part of each light fixture | Yes

LF callout block (long lamp label) DM_ELEC-LTG-CALLOUT-NCOLAMPS
LF callout block (short lamp label) DM_ELEC-LTG-CALLOUT-NOLAMPS
LF callout short label width 0.23

Display light fixture overlay During insertion

Block drm_elec-elevationLabel-device
Label SELEV

Schedule title justification Left

Schedule column label justification Center

Schedule title continued label (CONT.)

Show illuminance (fc) levels Yes

Show contours Yes

Decimal places on drawing 1

Decimal places in schedule 2

Reflections Mo reflection

Default grid spacing (ft-in) 10-0

Default vertical grid spacing (ft-in) 2-0

Default vertical display spacing (ft-in) 5-0

& Contours

Contour 1 illuminance (fc) 5
Contour 2 illuminance (fc) 2
Contour 3 illuminance (fc) 1
Contour 4 illuminance (fc) 0
Contour 3 illuminance (fc) 0
Contour & illuminance (fc) 0
Contour 7 illuminance (fc) 0
Contour 8 illuminance (fc) 0
Contour 9 illuminance (fc) 0
Contour 10 illuminance (fc) 0
Contour 1 layer or coler BYLAYER
Contour 2 layer or coler BYLAYER
Contour 3 layer or coler BYLAYER
Contour 4 layer or color BYLAYER
Contour 3 layer or color BYLAYER
Contour & layer or colar BYLAYER
Contour 7 layer or coler BYLAYER
Contour 8 layer or coler BYLAYER
Contour 9 layer or coler BYLAYER
Contour 10 layer or color BYLAYER
Leader arrow block DM_ELEC-ARROWHEAD
Leader arrow length 0.125

Cancel
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The Design Mas ter Photometrics Options dialog box contains a list of all of the options and their current
settings. The options are arranged in groups in the list.

Editing a Setting
To edit an option setting, select the Value in the list and enter a new value.

Press the OKbutton to save your changes.

If the change you made to the options does not immediately appear on the drawing, run the Coordinate Drawings
and Database command. This command will update the drawing to use the new settings you have specified.

IES Files

This section describes the options available in the IES Files group in the Design Mas ter Photometrics Options
dialog box.

GM Design Master Photometrics Options ped

Key Value

Copy IES files to project folder
Units
Light Fixtures
Light Fixture Elevation Labels
Schedules
Calculations
Calculation Areas
Contours
Leaders

-0+ 0 +

Cancel

Copy IES files to project folder: Whether IES files loaded into the Light Fixture Project Schedule are copied to
the project folder.

Units

This section describes the options available in the Photometric Calculations group in the Design Master
Photometrics Options dialog box.
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T Design Master Photometrics Options x

Key Value

IES Files
Project is metric Mo
Distance unit Inch
Numinance unit Foot-candle

]

Light Fixtures

Light Fixture Elevation Labels
Schedules

Calculations

Calculation Areas

Contours

Leaders

Cance

Most of these options set the default values when running the photometrics calculations. See the Calculate
section for more information about these settings.

Project is metric: Whether some distances and elevations are measured and displayed using meters or feet and
inches. See the Metric Units in DM Photometrics article in the knowledge base for more information.

Light Fixtures

This section describes the options available in the Light Fixtures group in the Design Master Photometrics
Options dialog box.

96


https://www.designmasterphotometrics.com/?p=2162

oM Design Master Photometrics Options x

Key Value
IES Files

Units

2 Light Fixtures

Insert callout as part of each light fixture | Yes

LF callout bleck {long lamp label) DM_ELEC-LTE-CALLOUT-MNOLAMPS
LF callout block (short lamp label) DM _ELEC-LTS-CALLOUT-NOLAMPS
LF callout short label width 0.23

Display light fixture overlay During inserticn
Light Fixture Elevation Labels
Schedules

Calculations

Calculation Areas
Contours
Leaders

00 B0 00O+

[ +]

Concel

Insert callout as part of each light fixture: Whether a light fixture callout note is automatically inserted as part of
each light fixture on the drawing.

LF callout block (long lamp label): The block used when you insert a light fixture callout. It is used when the lamp
label is wider than the value specified in LF callout short lamp label width.

LF callout block (short lamp label): The block used when you insert a light fixture callout. It is used when the
lamp label is smaller than the value specified in LF callout long lamp label width.

LF callout short label width: This width is used to determine which LF callout is inserted for a light fixture.

Display light fixture overlay: This specifies when a light fixture overlay will be displayed on non-plotting layers.
e Never: Light fixture overlays will never be inserted.
¢ During Insertion: The overlay will be displayed only when the light fixture is inserted. Once the light
fixture is inserted, the overlay is no longer displayed. To view the overlay again, you must insert a new
fixture.
® Always: The light fixture overlay will always be displayed.

Light Fixture Elevation Labels

This section describes the options available in the Light Fixture Elevation Labels group in the Design Master
Photometrics Options dialog box.
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OM Design Master Photometrics Options x

Key Value
IES Files
Units

Light Fixtures
& Light Fixture Elevation Labels
Block dm_elec-elevationlLabel-device

Label SELEV
Schedules
Calculations
Calculation Areas
Contours
Leaders

[H00--00 00+

Cance

Block: The block used for the elevation label when the Insert Elevation Label command is used.

Label: The text that is used to display the elevation in the label. $SELEV is replaced with the elevation.

Schedules

This section describes the options available in the Schedules group in the Design Master Photometrics Options
dialog box.
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oM Design Master Photometrics Options x

Key Value
IES Files

Units

Light Fixtures

Light Fixture Elevation Labels
Schedule title justification Left
Schedule column label justification Center
Schedule title continued label (CONT.)

Calculations

Calculation Areas

Contours

Leaders

Concel

Schedule title justification: Specifics whether the text in the title is left- or center-justified.
Schedule column label justification: Specifies whether the text in the column label is left- or center-justified.

Schedule title continued label: The text in this option is added to the schedule title when the schedule is broken
into multiple sections.

When inserting schedules, there is an option to set a maximum height for the schedule. If the schedule exceeds
this height, the schedule is continued in a second section next to the first. The title of the second and following
sections is the schedule title plus the text in the Schedule title continued label option.

Calculations

This section describes the options available in the Photometric Calculations group in the Design Master
Photometrics Options dialog box.
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T Design Master Photometrics Options x

Key Value

IES Files

Units

Light Fixtures

Light Fixture Elevation Labels

Schedules

Calculations
Show illuminance (fc) levels es
Show contours Yes
Decimal places on drawing 1
Decimal places in schedule 2
Reflections Mo reflection

Calculation Areas
Contours
Leaders

Cance

These options set the default values when running the photometrics calculations. See the Calculate section for
more information about these settings.

Calculation Areas

This section describes the options available in the Photometric Calculations group in the Design Master
Photometrics Options dialog box.
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oM Design Master Photometrics Options

Key Value
IES Files
Units

Light Fixtures

Light Fixture Elevation Labels
Schedules
Calculations
Calculation Areas
Default grid spacing (ft-in) 10-0
Default vertical gnid spacing (ft-in) 2-0
Default vertical display spacing (ft-in} 5-0
Contours
Leaders

These options set the default values when creating a new photometric calculation area or line. See the
Calculation Areas section for more information about these settings.

Contours

This section describes the options available in the Photometric Calculations group in the Design Master

Photometrics Options dialog box.
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GM Design Master Photormetrics Options >

Key Value

IES Files

Units

Light Fixtures

Light Fixture Elevation Labels

Schedules

Calculations

Calculation Areas
Contour 1 illuminance (fc) 5
Contour 2 illuminance (fc) 2
Contour 3 illuminance (fc) 1
Contour 4 illuminance (fc) 0
Contour 3 illuminance (fc) 0
Contour 6 illuminance (fc) 0
Contour 7 illuminance (fc) 0
Contour & illuminance (fc) )]
Contour 9 illuminance (fc) 0
Contour 10 illurminance (fc) 0
Contour 1 layer or coler BYLAYER
Contour 2 layer or coler BYLAYER
Contour 3 layer or coler BYLAYER
Contour 4 layer or color BYLAYER
Contour 3 layer or color BYLAYER
Contour & layer or coler BYLAYER
Contour 7 layer or coler BYLAYER
Contour 8 layer or coler BYLAYER
Contour 9 layer or color BYLAYER
Contour 10 layer or color BYLAYER

Cancel

Most of these options set the default values for contours when running the photometrics calculations. See the
Calculate section for more information about these settings.

Leaders

This section describes the options available in the Leaders group in the Design Master Photometrics Options
dialog box.
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oM Design Master Photometrics Options x

Key Value

IES Files

Units

Light Fixtures

Light Fixture Elevation Labels

Schedules

Calculations

Calculation Areas

Contours

Leaders
Leader arrow block DM _ELEC-ARROWHEAD
Leader arrow length 0.125

N +]

Concel

Leader Arrow Block: The block used for leader arrowheads.
Leader Arrow Length: The length of the leader arrowhead.

Block Creation

This section describes the commands used to create custom light fixture blocks.

Create Plan View Block from Entities

The Create Plan View Block from Entities command is used to create a block that can be used in your
plans to represent a light fixture. Specific entities on the current drawing are used to create the block. The entities
selected will be removed from the drawing during this process.

To create the block, go to

Ribbon: DM Photo: Customization->Block Creation-> @ Create Plan View Block from

Entities

Pulldown Menu: DM Photometrics->Customization->Block Creation->Create Plan View Block
from Entities

Create Plan View Block Dialog Box
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Create Plan View Block >

Block MName: |
Folder: C:\dmsupport®,_customization Set Folder. . .
Block Settings Slide Settings
Move entities to layer 0 §f unsure, leave this checked) Create slide

[ ] Block has a highlight {used to display muttiple colors) Block Colar:

o
Block can rotate Select Block Color. . .
Block iz "To Scale”
Check "To Scale” for light fistures and devices that are inserted at actual size. Highlight Color:
Do not check "To Scale” for receptacles and devices that are symbolic. Select Highlight Calar. . .
Connect leaders to. . .
(®) Specific points
() Edge of a circle

() Edge of a rectangle

Database Settings
[ ] Create reconds in database

Ay maszter or project walue left blank will uze the "Block Mame' walue from above.
Master Schedule Reconds

Create record in master block list: | |

Create record in master schedule: | |

kazter Schedule Group:

Project Schedule Records
Create record in project block list: | |

Create record in project schedule: | |

Cancel

Block Name: The name ofthe block. This will be the name of the block on the drawing and the name of the
drawing file saved to your computer.

Folder: The folder where the block will be saved. The default location is your customization folder.

Set Folder: Press this button to change the folder where the block will be saved.

Block Settings

Move entities to layer 0: Whether the entities you select for the block are moved to layer 0 or left on the layer
they are currently on. If you are not sure what this means, leave this box checked.
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See the help for your CAD program for more information about setting layers in blocks.

Block has a highlight: Whether the block has a highlight associated with it. Highlights are used to include a
second layer and color in blocks. The highlight block is inserted on a separate layer fromthe main device block.
The two layers can have different colors and other properties set on them.

Block can rotate: Whether the block can be rotated. See the Can Rotate section for more information.
Block is "To Scale'": Whether the block is to scale. See the To Scale section for more information.

Connect leaders to: Where leaders are connected to the block.
e Specific points: The leaders are connected to specific points on the block. Choose this option for blocks
that are not circles or rectangles.
* Edge of a circle: The leaders are connected to the edge of a circle. Choose this option if the block has a
circle in it that you want the leaders to connect to.
* Edge of a rectangle: The leaders are connected to the edge of a rectangle. Choose this option if the block
has a rectangle in it that you want the leaders to connect to.

Slide Settings

Create slide: Whether a slide for the block will be created automatically. The slide is used in the light fixture
dialog boxes to display the graphics.

If you do not create a slide for a block, an "X" will be shown in the dialog boxes. The block will still display
properly on the drawing.

You can manually create the slide later using the Create Slide command.

Block Color: The color to use for the block in the slide.

Select Block Color: Press this button to set Block Color using the standard CAD Select Color dialog box.
Highlight Color: The color to use for the highlight block in the slide.

Select Highlight Color: Press this button to set Highlight Color using the standard CAD Select Color dialog
box.

Database Settings

Create records in database: Whether records will be created in the master and/or project databases.

Master Schedule Records

Create record in master block list: Whether the block is added to the master block list. If this boxis checked,
you can specify a label for the block in the master list. If you leave the label field blank, the block name is used as
the label in the master list.

Create record in master schedule: Whether a record using the block is created in the master schedule. If this box
is checked, you can specify a name for the entry in the master schedule. If you leave the name field blank, the
block name is used as the name of the entry in the master schedule.
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Master Schedule Group: The group with which the record will be associated in the master schedule.

Project Schedule Records

Create recordin project block list: Whether the block is added to the project block list. If this boxis checked,
you can specify a label for the block in the project list. If you leave the label field blank, the block name is used as
the label in the project list.

Create recordin project schedule: Whether a record using the block is created in the project schedule. If this box
is checked, you can specify a name for the entry in the project schedule. If you leave the name field blank, the
block name is used as the name of'the entry in the project schedule.

Enter the information needed to create the plan view block and press the OK button.

You will be prompted to select entities on the drawing to include in the block.

Select entities to use in the block:

Ifthe block has a highlight, you will then be prompted to specify entities for the highlight block.
Select entities to use in the highlight block:

You will then prompted to specify the insertion point for the block.

Specify insertion base point:

You will then be prompted to specify where leaders will connect to the block. The prompts depend upon the
option you chose in the dialog box.

® Specific points: Specify the points where leaders can connect to the block. You may specify as many
points as you need.

Specify connection point:
* Fdge of a circle: Specify two points on opposite sides of the circle to connect the leaders to.

Specify point on one side of circle:
Specify point on opposite side of circle:

¢ Edge of a rectangle: Specify two corners of the rectangle to connect the loops and leaders to.

Specify first corner of rectangle:
Specify opposite corner of rectangle:

The block, slide, and database records will be created for you. The entities selected for the block will be removed
fromthe drawing.

Ifaslide is created, the screen will flash during the creation process. When it is finished, you should return to
your original view of the drawing.
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Create Plan View Block from This Drawing

The Create Plan View Block from This Drawing command is used to configure your current drawing to
work as a custom photometrics block.

You can manually create a slide for the block using the Create Slide command.

To configure the current drawing, go to

Ribbon: DM Photo: Customization->Block Creation-> Eﬁ Create Plan View Block from This
Drawing

Pulldown Menu: DM Photometrics->Customization->Block Creation->Create Plan View Block
from This Drawing

You will be prompted to specify the insertion point for the block.
Specify insertion base point:
The Design Master Photometrics dialog boxshown below will appear.

Design Master Photormetrics >

Where do you want loops to connect to this device?

I To Edge of Cincle I To Edge of Rectangle To Points

Press the To Edge of Circle button to connect loops to the edges of a circle on this block. Press the To Edge of
Rectangle button to connect loops to the edges of a rectangle on this block. Press the To Points button to
connect loops to points on this block.

Connecting Loops to the Edge of a Circle

Ifthe To Edge of Circle button is pressed, you will be prompted to specify a point on one side of the circle.
Specify a point on one side of circle:

You will then be prompted to identify a point on the opposite side of the circle.

Specify a point on opposite side of circle:

Connecting Loops to the Edge of a Rectangle

If the To Edge of Rectangle button is pressed, you will be prompted to identify the location of the first corner of
the rectangle.

Specify first corner of rectangle.

You will then be prompted to identify the location of the opposite comner.
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Specify opposite corner of rectangle.

Connecting Loops to Points on the Device

Ifthe To Points button is pressed, you will be prompted to identify the location where the loop is to connect to
the device.

Specify connection point:

Specify as many connection points as desired for the block. Press ENTER to finish the command.

Create Slide

The create Slide command is used to create a slide using an area of your drawing. A slide is an image file that
is displayed in dialog boxes to represent the block that is selected.

The slide file must have the same name as the block that it represents. If a block is selected that does not have a
corresponding slide, an "X" will be shown in the dialog boxinstead. The block will still insert properly if a
corresponding slide does not exist.

To create a slide, go to

Ribbon: DM Photo: Customization->Block Creation-> l:l Create Slide

Pulldown Menu: DM Photometrics->Customization->Block Creation->Create Slide

Save Slide As Dialog Box
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B SaveSlide As »
Savein: | Blectrical W | G ? ¢ =
% Mame Date modified Type
_ D dm_elec-If1.sld 71172018 10:20 AM - AuteC
Quickaccess [y elec-If2.sld 7/11/2012 10:20 AM  AutoC
[T dm_elec-If3.sld 7172018 10:20 AM - AuteC
- [T dm_elec-lf4.sid 7172018 10:20 AM AuteC
Desktop [T dm_elec-If5.sld 71172018 10:20 AM - AutoC
- [[]dm_elec-If6.sld TAT201810:20 AM AutoC
m [[7)dm_elec-1f7.sld 7172018 10:20 AM - AuteC
Libraries D dm_elec-If&.sld 7172018 10:20 AM AuteC
. D dm_elec-If9.sld 712018 10:20 AM - AuteC
L! D drm_elec-If10.sld TA12018 10020 AM AutoC
This PC [T dm_elec-1f11.51d 12018 10:20 AM AuteC
[T dm_elec-If12.5ld 71172018 10:20 AM AuteC
L# [(Cldm elec-If13.sld 7/11/2018 10:20 AM  AutoC ¥
M ef;unrk ¢ ’
File name: ~ | | Save I
Save as type: SLD Files (~.sld) w Cancel

Specify the name of the slide file to create, then press the Save button to create the slide.

You will be prompted to draw a boxon your drawing. A snapshot of everything inside the box will be saved in the
slide.

Specify first corner of slide:

You will then be asked to specify the opposite corner of the box.
Specify second corner:

The screen will flash while the slide is being created.

Insert Non-Rotating Text

The Insert Non-Rotating Text command is used to create text that can be included in a customblock that
will not rotate when the block is rotated.

Normal CAD text rotates when a block is rotated. If a block is rotated 180 degrees, the text will appear upside-
down.

Text created using this command will always be displayed at angle 0. When the block is rotated, the text is rotated
backto 0.

To insert non-rotating text on the current drawing, go to
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Ribbon: DM Photo: Customization->Block Creation-> hﬂ Insert Non-Rotating Text

Pulldown Menu: DM Photometrics->Customization->Block Creation->Insert Non-Rotating Text
You will be prompted to identify where the non-rotating text is to be inserted on the drawing.

Insertion point for non-rotating text:

The point specified will be the center point for the inserted text. You will then be prompted to enter the text itself.
Text value:

You will then be prompted to specify the height of the text.

Text height:

The text will be inserted on the drawing.

Once the text is inserted, you can modify it using standard CAD commands.

Make sure you select the text when choosing entities to create a block.

Open Block from Drawing

The Open Block from Drawing command is used to select a block on the drawing and open it in your CAD
program. This command is useful when making changes to your customization. To make a change to a block that
appears on your drawing, you can select it using this command.

To open a block from the current drawing, go to

Ribbon: DM Photo: Customization->Block Creation->Open Block from Drawing

Pulldown Menu: DM Photometrics->Customization->Block Creation->Open Block from Drawing
You will be prompted to select the block to be opened.

Select block to open:

The drawing that the selected block is based upon will be opened. Use standard CAD commands to make
changes to the block.

After changes are made to the block, use the Redefine Block in this Drawing command to update the block
definition on the current drawing. Otherwise, none of the changes you made will appear on your drawing.

Redefine Block in this Drawing

The Redefine Block in this Drawing command is used to update a block definition on a drawing after
changes have been made to the drawing the block is based upon.

When a block is inserted on the drawing, the definition for that block is stored on the drawing. If the drawing that
the block is based upon is later changed, the definition on the drawings where it has been inserted is not updated.
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You must update the block definition manually. It is possible to do this using the standard CAD INSERT
command, but the Redefine Block in this Drawing command simplifies the process.

To update a block on you drawing, go to
Ribbon: DM Photo: Customization->Block Creation->Redefine Block in this Drawing

Pulldown Menu: DM Photometrics->Customization->Block Creation->Redefine Block in this
Drawing

You will be prompted to select the block to be updated.
Select block to redefine:
The definition for the selected block will be updated to match the drawing that it is based upon.

Light Fixture Blocks

The Light Fixture Blocks commands allow you to customize the list of blocks available to be used for light
fixtures in the project and master schedules.

See the Block Creation section for more information about creating new blocks.

See the General Customization Commands section for more information about how the Edit Project List,
Edit Master List,Copy Project List to Master,and Copy Master List to Project commands
work.

To edit the light fixture blocks project list, go to

Ribbon: DM Photo: Customization->Project Customization-> [] Light Fixture Blocks
Pulldown Menu: DM Photometrics->Customization->Light Fixture Blocks->Edit Project List

To edit the light fixture blocks master list, go to

Ribbon: DM Photo: Customization->Master & Standards Customization-> Eg Light Fixture
Blocks

Pulldown Menu: DM Photometrics->Customization->Light Fixture Blocks->Edit Master List

Light Fixture Blocks Dialog Box

111



6 Light Fixture Blocks x

Sort Mowve Lip Mowe Down Mew Delete

Block Mame To Scale | Can Rotate

Description

DM_PHOTO-LF51
Round Wall Mounted (Small) | DM_PHOTO-LF41 O
Round Wall Mounted (Large) | DM_PHOTO-LF15 O
Square Wall Mounted DM_PHOTO-LF14 O
Round (Tiny) DM_PHOTO-LF32 O O
Round (Small) DM_PHOTO-LF23 O O
Round (Medium) DM_PHOTO-LF24 O O
Round (Large) DM_PHOTO-LF25 (| (|
Square (Tiny) DM_PHOTO-LF33 (|
Square (Small) DM_PHOTO-LF29 (|
2x Wall Mounted Fluorescent | DM PHOTO-LF13 [ [vl R

Cancel

Sort: Press this button to sort the list of blocks alphabetically by the Description column.
Move Up: Press this button to move the selected block up in the list of blocks.

Move Down: Press this button to move the selected block down in the list of blocks.

New: Press this button to create a new block.

Delete: Press this button to delete the selected block. If the block is currently used by a record in the schedule,
you will be asked if you want to replace the block in the schedule with another block.

Description: The name of the block that is displayed when you select the block in the light fixture schedule dialog
box.

Block Name: The file name of the block displayed on the plan.
To Scale: Whether the block is to scale.

Blocks that are to scale are inserted on the drawing at their actual size. The scale factor for the block will be 1.
Changing piMscaLE will not change the size of the block. Light fixtures are commonly inserted to scale.

Blocks that are not to scale will vary in size depending upon the scale of the drawing. The scale factor of the
block will be equal to the pIMSCALE setting of the drawing. Changing biMscaLE will change the size of the light
fixture.

Can Rotate: Whether the block can be rotated.

When a block that can be rotated is inserted, you are prompted to specify the rotation angle. They can be rotated
using the standard CAD ROTATE command.
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When a block that cannot be rotated is inserted, you are not prompted to specify the rotation angle. The block is
inserted with a rotation angle of 0. If you attempt to rotate the block, the rotation angle will be reset to 0.

Print Blocks

The print Blocks command is used to print all of the light fixture blocks in your database on the drawing. You
can use this command to review all of the blocks that are defined in your database

To insert a table of all available blocks on your drawing, go to
Ribbon: DM Photo: Customization->Block Creation->Print Blocks

Pulldown Menu: DM Photometrics->Customization->Light Fixture Blocks->Print Blocks

Design Master Photometrics Dialog Box

Design Master Photormetrics >

Prirt blocks from master database or project database?

Master Project

Master: Press this button to print light fixture blocks from the master database.
Project: Press this button to print light fixture blocks fromthe project database.
Cancel: Press this button to exit the command.

After you select which database to print light fixture blocks from, you will be prompted to select an insertion point
for the table.

Insertion point:

A table of blocks will be inserted on the drawing. The appearance of this table cannot be customized. It is
intended for internal review purposes and not to be published in your final plans.
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Layers

The Layers command is used to customize the layers used when inserting items on the drawing.

See the General Customization Commands section for more information about how the Edit Project List,
Edit Standards List,Copy Project List to Standards,and Copy Standards List to Project
commands work.

To edit the layers project list, go to

Ribbon: DM Photo: Customization->Project Customization-> ﬁ Layers
Pulldown Menu: DM Photometrics->Customization->Layers->Edit Project List

To edit the layers standards list, go to

Ribbon: DM Photo: Customization->Master & Standards Customization-> @ Layers

Pulldown Menu: DM Photometrics->Customization->Layers->Edit Standards List

Layers Dialog Box
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Plot Style

Layer Systems

Move Up: Press this button to move the selected row up in the Layer System list.

Move Down: Press this button to move the selected row down in the Layer System list.

New System: Press this button to create a new layer system.

Edit System: Press this button to open the Layer System Options dialog box for the selected layer system.

Layer System: The name of the layer system.

Delete System: Press this button to delete the selected layer system.

Layer System: The list of layer systems currently defined.

115




General: This layer systemis used to store all of the layers not associated with devices, such as
photometrics and schedules. Light fixtures cannot be assigned to this layer system. It cannot be deleted or
moved.

Layer Keys

Undo Layer Key Changes: Press this button to revert the layer key settings to their values when the dialog box
was opened.

Layer Key: This column lists all of the different items that can be inserted using the software. The names in this
column are fixed. Each layer key can be mapped to a layer that will be used when that type of itemis inserted on
the drawing. Multiple layer keys can use the same layer. See the General Layer Keys and Other Layer Keys
sections for more information about which entities on the drawing use which layer key.

Layer Name: This column lists the layer that will be used when inserting items of the corresponding Layer Key
type on the drawing. The layers you can choose fromare defined in the lower section of the dialog box.

Layers

The layer list displays all of the layers that can be assigned to layer keys. The settings for each layer can be set in
the list.

Layer Name: The name of the layer.

Color: The color number of the layer.

Linetype: The linetype of the layer.

Plot: Whether the layer will be plotted.

Lineweight: The lineweight of the layer. Only used when plotting using STB's.

Plot Style: The plot style of the layer. Only used when plotting using STB's.

Managing Layers

The following buttons in the Layers dialog boxcan be used to manage the layers in the dialog box.
Delete All Unused Layers: Press this button to delete all layers that are not associated with a layer key.
New Layer: Press this button to add a new layer.

Delete Layer: Press this button to delete the selected layer.

Undo Layer Changes: Press this button to revert the layer settings to their values when the dialog box was
opened.

Using Excel to Modify Layer Settings
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The Import Layers from Excel and Export Layers to Excel buttons are used to import and export the layer
settings to Excel. Using Excel is recommended when modifying large numbers of layer settings.

Import Layers from Excel: Press this button to load the layer setting information entered in Excel into the dialog
box. The layer settings will be applied to the selected layer system.

Export Layers to Excel: Press this button to export the layer settings to a CSV file that can be opened in Excel.
The Save Layer File As dialog box will appear.

A Save Layer File As *
Savein: | Tutorial w | [« W
l Mame Date modified Type
_ DMBackup 97472018 10:18 AM File folder
sAzETEEE DME Manual 8/28/2018 250 PM  File folder
- HWALC 8/29/2013 2:44 PM File folder
Photometric 8/8/2018 1:28 PM File folder
Desktop
™
Libraries
This PC
@ £ >
Metwork
File name: Blec Layers - General C5V w | | Save I
Save astype: CSV Files (“.CSV) w Cancel

The selected layer system will be saved to the file you specify. The file will be opened for immediate editing.
When modifying the file, do not change the header rows, the first column, or the last column. Restrict your
changes to the Layer Name, Color, Linetype, Plot, Lineweight, and Plot Style columns.
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General Layer Keys

The General layer keys are used for entities that are always inserted on the same layer. Each layer key and its
corresponding entities are listed below.

DEFAULT: The default layer used for entities when a layer key is missing or otherwise cannot be found.
PHOTOMETRIC BOUNDARY: Used for calculation area boundaries.

PHOTOMETRIC CONTOUR: Used for contours inserted during the calculation.

PHOTOMETRIC LIGHTING OVERLAY: Used for light fixture illuminance overlays.

PHOTOMETRIC MASK: Used for masks.

PHOTOMETRIC SOLID: Used for solids.
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PHOTOMETRIC TEXT: Used for the illuminance levels in the calculation area.

SCHEDULE-HEAVY: A heavy layer used in schedules. Used for the outside border, the title border, and the
column label borders.

SCHEDULE-LIGHT: A light layer used in schedules. Used for the inside borders.
SCHEDULE-TEXT: Used for the text in schedules.

Other Layer Keys

The other layer keys are used when inserting light fixtures on the drawing. Each light fixture is assigned a layer
system. Each layer system has the following layer keys associated with it. To change the layer of a light fixture,
change the layer system. Do not change the layer directly in your CAD program. If you do, it will likely be
changed back at some point in the future.

LIGHT FIXTURES: Used for the light fixture block.

LIGHT FIXTURES-CALLOUT: Used for the light fixture callout block.

LIGHT FIXTURES-HIGHLIGHT: Used for the light fixture highlight block, if one exists.
LIGHT FIXTURES-LEADER: Used for the leader from notes.

LIGHT FIXTURES-TEXT: Used for notes on the light fixture.

Update Drawing Layers to Match Project
List
The Update Drawing Layers to Match Project List command is used to update the layer definitions on

the drawing. Once a layer is created on a drawing, it is not modified. Changes you make to the color, lineweight, or
other attributes are not overwritten. This command is the only way to modify layers that already exist.

To update existing layers on a drawing to match new definitions in the project list, go to

Ribbon: DM Photo: Customization->Project Customization-> Eﬂ Update Drawing Layers to
Match Project List

Pulldown Menu: DM Photometrics->Customization->Layers->Update Drawing Layers to Match
Project List

The layer definitions on the drawing will be updated to match the definitions in the project list.

Schedules

This section describes how to customize the layout of the light fixture schedule and calculation area schedule in
the master and standards databases. Changing the values in these locations will allow themto be used in newly
created projects.
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Edit Light Fixture Schedule Master
Settings

The Edit Light Fixture Schedule Master Settings command is used to change the appearance ofthe
light fixture schedule in the master database. Changes made this way will affect newly created projects.

To edit the light fixture schedule master settings, go to

Ribbon: DM Photo: Customization->Master & Standards Customization-> Eb Light Fixture
Schedule Master Settings

Pulldown Menu: DM Photometrics->Customization->Schedules->Edit Light Fixture Schedule
Master Settings

See the Edit Light Fixture Schedule Layout section for more information.

Edit Calculation Area Schedule Standards
List
The Edit Calculation Area Schedule Standards List command is used to change the appearance of

the photometric calculation area schedule in the standards database. Changes made this way will affect newly
created projects.

To edit the photometric calculation area schedule standards settings, go to

Ribbon: DM Photo: Customization->Master & Standards Customization-> Eb Calculation Area
Schedule Label Group

Pulldown Menu: DM Photometrics->Customization->Schedules->Edit Calculation Area
Schedule Standards List

See the Edit Calculation Area Schedule Layout section for more information.

Edit Calculation Line Schedule Standards
List

The Edit Calculation Line Schedule Standards List command is used to change the appearance of
the photometric calculation line schedule in the standards database. Changes made this way will affect newly
created projects.

To edit the photometric calculation line schedule standards settings, go to

Ribbon: DM Photo: Customization->Master & Standards Customization-> Eb Calculation Line
Schedule Label Group

Pulldown Menu: DM Photometrics->Customization->Schedules->Edit Calculation Line
Schedule Standards List

See the Edit Calculation Line Schedule Layout section for more information.
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Text Styles

The Text styles commands allow you to customize the text heights and fonts used for labels and schedules.

See the General tomization Commands section for more information about how the Edit Project List,
Edit Standards List,Copy Project List to Standards,and Copy Standards List to Project
commands work.

To customize text styles in the current project, go to

Ribbon: DM Photo: Customization->Project Customization-> M8 1oyt Styles

Pulldown Menu: DM Photometrics->Customization->Text Styles->Edit Project List

To customize standard text styles, go to

Ribbon: DM Photo: Customization->Master & Standards Customization-> ﬂa Text Styles

Pulldown Menu: DM Photometrics->Customization->Text Styles->Edit Standard List

Text Styles Dialog Box

BM Text Styles *

Values left blank will use the default.

Text Style Key Text Style | Height | Scale Factor
DEFAULT SIMPLEX | 0.1 0.8

LIGHT FIXTURE CALLOUT
LIGHT FIXTURE MOTES
LIGHTING GROUP LABEL
PHOTOMETRIC
SCHEDULE CELL

SCHEDULE COLUMM HEADER | ITALIC
SCHEDULE HEADER [TALIC 0.2

ok || cancel

Text Style Key: This list indicates where the text style is used. These values cannot be edited.

Text Style: Sets the text style in your CAD programto be associated with the corresponding Text Style Key. The
Default key must have a text style defined. The text style in other keys may be left blank. Blank keys will use the
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text style defined for the Default key.
If the text style currently exists in the drawing, it will be used as defined.

If the text style does not exist, it will be created using an SHX file of the same name. If an SHX file cannot be
found, the Standard text style will be used.

To use a TrueType font, create the text style and associate it with the desired font.

Height: Sets the text height for the key. The Default key must have a height defined. The height in other keys
may be left blank. Blank keys will use the height defined for the Default key.

The units for the height are inches on the printed page. To set 1/10" text for the drawing, use the value 0.1. To set
1/8" text, use 0.125. When text is inserted, this value will be multiplied by pIMsScALE to determine the height of
the text on the drawing.

Scale Factor: Sets the character spacing for the text. This value is not currently used.

Recreate Missing Customization

To recreate customization that is missing in the project or standards database, go to

Ribbon: DM Photo: Customization->Customization Utilities->Recreate Missing
Customization

Pulldown Menu: DM Photometrics->Customization->Recreate Missing Customization
Design Master Photornetrics >

Select the database to recreate the customization in.
You can select either a project database or a standards database.

Press the OK button. The Select Standards or Project Database dialog box will open.
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A Select Standards or Project Database x
Lok in: | | | 13 Final Qutput v| @@ @
i Mame Date modified Type
_ DMBackup 2/27/2019 215 PM  File folder
Quickaccess ™ 4 clec.dm 2/27/20193:14PM DM File
Desktop
m
Libraries
This PiC
* < >
Lé File name: || w | Open
Metwork
Files of type: DM Files {*.dm) o Cancel
[ ]10Open as read-only

Select the standards or project database and press the Open button. Any missing customization records will be
added to the database. It will not change any existing customization values.

The Select Standards or Project Database dialog box will open the current project folder by default. To update
your standards database, you must browse to your customization folder.

The default location for the customization folderis C: \Users\<User Name>\AppData\Roaming\Design
Master Software\Photometrics Customization where <User Name> is the name you use to log in to your
computer.

Update Laptop Customization

The Update Laptop Customization command is used to update the local customization on a laptop to match
the customization stored on the network. The local customization is automatically updated once a day when you
open your CAD program. This command is used to manually update the local customization. It is only necessary
to use this command if the customization on your network has changed during the day.

To update the local customization on a laptop, go to
Ribbon: DM Photo: Customization->Customization Utilities->Update Laptop Customization
Pulldown Menu: DM Photometrics->Customization->Update Laptop Customization

The customization will be copied from the network to the local drive.
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See the Installation Settings section for more information about configuring your computer as a laptop.

Manage Standards Databases

The Manage Standards Databases command is used to create, modify, and delete standards databases. Each
standards database has its own set of customization settings. Multiple standards databases are used when more
than one set of standards is used in a company.

To manage your standards databases, go to
Ribbon: DM Photo: Customization->Customization Utilities->Manage Standards Databases
Pulldown Menu: DM Photometrics->Customization->Manage Standards Databases

If only one standards database exists, you will be prompted to create a new one. If you do not create another
database, the command will end. If you do create another database, the Select Standards Database dialog box will
then appear.

If more than one standards database exists, the Select Standards Database dialog box will appear.

Select Standards Database Dialog Box

Select Standards Database >

Imperial - Inch Base Unit
Metric — Centimeter Baze Unit
Metric — Meter Base Linit

Rename =
Set Default

MNew < Copy < Delete

Cancel

Each standards database is a separate file stored in your customization folder. The file name will be "dm _elec-
standards<Name>.dm", where <Name> is the name of the standards database as displayed in the dialog box Ifa
standards database is named "dm_elec-standards.dm", it will display as "Default".

The default location for the customization folderis C: \Users\<User Name>\AppData\Roaming\Design
Master Software\Photometrics Customization where <User Name> is the name you use to log in to your
computer.
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Rename: Press this button to rename the selected standards database. The name that is displayed and the name
of'the file will be changed.

Rename: Press this button to set the selected standards database as the default when starting a new project.

New: Press this button to create a new standards database. A new standards database file will be created in the
customization folder.

Copy: Press this button to copy the selected standards database. A new standards database file with the same
settings will be created in the customization folder.

Delete: Press this button to delete the selected standards database.
Start New Photometrics Project
This section describes how to start a new project.

When you start a new project, a database file will be created in the same folder as the current drawing. The file
name willbe "dm elec<Name>.dm", where <Name> is the name of the project. This is the database file where all of
the information about your project is stored.

To create a new database file, go to

. . L HEL ) .
Ribbon: DM Photometrics->Utilities-> MII Start New Photometrics Project

Pulldown Menu: DM Photometrics->Start New Photometrics Project

Start New Photometrics Project Dialog Box

Start Mew Photometrics Project *

Project Name (Optional): | |
Project Directony: C:4\Users’Kane'\Desktop® Tutoral Phatometric’13 Final Output®

Standards Database: | perauy e

(] Light Fixture Schedule Group: General

Cancel

Project Name (Optional): The project name that is added to the end of the file name. This name is only used on
the file name. It is not used anywhere else in the project. If you leave this field blank, the project database name
will be "dm_elec.dm".

Project Directory: The folder in which the database will be created. The folder displayed and used is the folder
that contains the current drawing.

Standards Database: The standards database from which to copy project options and settings. See the Master
and Standards Databases section for more information about the standards database and which settings are
stored in it.

125



Light Fixture Schedule Group: Check this box to import a complete light fixture group fromthe master database
to the new project. See the Light Fixture Master Schedule Groups section for more information about light fixture
groups.
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Concepts and Procedures

This sections describes concepts and procedures you will use with Design Master Photometrics. It describes
how to apply the commands in the Command Reference section to create your photometrics project.

Project Drawing and Database
Management

When you create a new project, a database file will be created in the same folder as the current drawing. The file
name will be "dm_elec<Name>.dm", where <Name> is the name of the project. This is the database file where all of
the information about your project is stored. Your project drawings are now connected to this database file, and
the information contained in the drawings and the database must match.

You must consider how changes to your drawings will affect the database. Recommendations for common
scenarios when working on a Design Master Photometrics project are listed below. You can also visit the Project
and Database Management Webinar in the knowledge base.

Project Folders

Each project needs to be in a separate folder that contains one dm_elec.dm database file. All of the drawing files
for the project need to be in the same folder as the database. You should not copy drawings from one project to
another.

Saving Your Changes

Always save your changes to a drawing with Design Master Photometrics devices in it. Never close a drawing
without saving your changes.

Any changes you make to the drawing are saved to the database immediately. If you close the drawing without
saving, the database and drawing will no longer match. This can result in missing or extra devices, incorrect
calculations, and other problems.

If you close a drawing without saving, or your CAD program crashes, use the Coordinate Drawings and Database
command to make the drawing and database match again.

Creating a Backup

To back up your project, you must copy both the drawings and the database file. Copying just the drawings is
not enough.

The two simplest methods are copying the entire folder to a new location, or using the Copy or Backup Project
command.

Alternative Designs

To try an alternative design in your project, do not copy drawings inside the same project folder. This will result
in duplicate devices and inaccurate calculations. Instead, make a copy of the project in its own folder. Treat the
alternative design as a separate project.
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Copy the entire folder to a new location, or use the Copy or Backup Project command.
Copying a Drawing

To copy a drawing that contains Design Master devices, use the Copy Drawing command. This will create an
exact copy of the drawing in the project folder. Copies of all of the devices on the drawing will be created in the
database.

(You can use Windows Explorer or the standard CAD saveas command to copy a drawing, but these methods
add some complications so we do not recommend them.)

Renaming a Drawing

To rename a drawing that contains Design Master devices, use the Rename Drawing command. This will rename
the drawing. The original drawing will no longer exist.

(You can use Windows Explorer or the standard CAD savEas command to rename a drawing, but these methods
add some complications so we do not recommend them.)

CAD Program Crashes

CAD program crashes can leave your drawing and your database in an inconsistent state. This is a special
situation that needs to be handled carefully to prevent your database frombeing corrupted.

Your CAD Program Created a Recover Drawing

If your CAD program created a recovery drawing, try to open that file. If it opens, compare it with the original
drawing file. Decide which you want to use. If you want to use the recovery drawing, rename the original
drawing something different using Windows Explorer, then rename the recovery drawing to the original
drawing name using Windows Explorer. Run the Coordinate Drawings and Database command on the
drawing to make the drawing and database match, then continue working.

If you choose to work in the original drawing, delete any recovery drawings that were created. Run the
Coordinate Drawings and Database command on the original drawing to make the drawing and database
match, then continue working.

Your CAD Program Did Not Create a Recover Drawing

If your CAD programdid not create a recover drawing, then you must open your original drawing. Run the
Coordinate Drawings and Database command on the drawing to make the drawing and database match, then
continue working.

Master and Standards Databases

The master and standards databases are used to store default settings for new projects. You can make changes to
the customization settings, store themin these files, and reuse them.

These databases are stored in your photometrics customization folder. For companies with more than one user,
we recommend that the photometrics customization folder be on your network. This allows you to share the
customization between all of your users. Otherwise, synchronizing the customization on all of the different
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computers is complicated.

When you create a project, the settings fromthe master and standards databases are copied to its project
database. Once it is created, the project database is no longer associated with the master or standards database.
Changes to the project database will not affect the master or standards database, and changes to the master and
standards databases will not affect the project database.

Master Database

There is only one master database. All of the blocks are stored in the master, as well as the various schedules.

When a project is created, all of the block records are copied from the master to the project database. You can
choose to copy a specific group fromeach of the master schedules to the project database.

The master database stores the following information:

¢ Light Fixture Blocks
¢ Light Fixture Master Schedule

Standards Databases

Multiple standards databases can be created. Each standards database has its own set of customization settings.

When a project is created, the customization settings are copied froma selected standards database. Everything
fromthe standards database is copied to the project and used as the default settings.

The standards database stores the following information:
® Layersystems

Layer definitions

Options settings

Text styles

Calculation Basis
Multiple Areas

Multiple calculation areas can be defined on a single drawing.

Reflections

Reflections frombuildings and walls can be included in the calculation. Each wall has a reflectance value that is
used to calculate the amount of light that it reflects. For outdoor photometrics, this reflection results in slightly
higher values near buildings.

IES Files

The illuminance level at each point within a defined boundary is calculated using the IES file for each light fixture.
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Technical Support

Technical support is available by phone, email, or live chat on our website. We are available Monday through
Friday, 9amto Spm Eastern time.

Limited support by email is available evenings, weekends, and holidays.

Email: support@designmaster.biz

Phone: 1-866-516-9497 x2

Live Chat: http://www.designmaster.biz/chat/
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System Requirements

To run Design Master Photometrics, you need AutoCAD 2007 or later or BricsCAD within the last 3 years, and a
computer capable of running your specific version of AutoCAD or BricsCAD.

Complete system requirements are available on our website.
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Purchasing

Pricing information and purchase links are available on our website.
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